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C H A P T E R  1  

How to find help 

1.1  Use the quick reference booklet 

A quick reference booklet is included in the box containing your SuperNova 

software. This book contains information on getting started with SuperNova, 

covering the popular hot keys you use with this software. 
  

1.2  Hotkey Helper 

SuperNova contains a large number of hot keys for accessing useful 

features or product settings via a quick simple keypress. SuperNova's 

Hotkey Helper function helps you find the correct hot key combination for a 

specific feature or product setting when you can't remember what the hot 

key is.  

For example, if you have a speech edition of SuperNova, you may want to 

find the hot key combination for announcing the contents of Excel's formula 

bar aloud. So instead of opening the SuperNova application-specific help 

file for Excel and reading through all of the available hot keys, or entering 

SuperNova's Key Describe Mode, CAPS LOCK + FORWARD SLASH, and 

then pressing various key combinations until you find the correct hot key, 

you can instead open SuperNova's Hotkey Helper window, by pressing 

LEFT SHIFT + CAPS LOCK + F2, or by selecting the "Hotkey Helper" 

menu item from SuperNova's CAPS LOCK + F1 help menu, and typing the 

word formula in the search edit box in the Hotkey Helper HTML window in 

order to view a list of all of the hot keys related to working with formulas. 

If you start a Hotkey Helper search with the ^ symbol (SHIFT+6 on your 

keyboard, and sometimes referred to as a freestanding circumflex, or hat, 

or up arrow symbol), SuperNova's Hotkey Helper will search application 

names rather than hot key descriptions. So the search phrase ^acrobat 

will list all of the available hot keys in Adobe Reader. 
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You can use SuperNova's standard web browsing keys to review the 

contents of your search in SuperNova's Hotkey Helper HTML 

window. 

 
  

1.3  Get help using an application 

SuperNova includes help on how to use many popular applications. 

Help includes: 

 How to configure the application for best performance. 

 How to complete many common tasks using only the keyboard. 

 A list of popular hot keys. 

While SuperNova is running, you can open the SuperNova Help from within 

your application. When you open the SuperNova Help menu, the first item 

will link to specific information about using SuperNova with the current 

application. 

To do this: 

1. Press CAPS LOCK + F1. 

A context menu opens. 

2. DOWN ARROW to select the name of your application. For example, 

Microsoft Word 2007 and then press ENTER. 

SuperNova opens an HTML Help window, which contains  the 

help content. 

When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
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1.3.1  Move within help topics 

You can use Arrow Keys to move around within topics. In addition, you can 

use the following web page navigation commands to move around within 

help topics. Visit the Internet Explorer section of the SuperNova manual For 

a complete list of hot keys for moving around web pages. 

 Move to the next link, TAB. 

 Move to the previous link, SHIFT + TAB. 

 Move to the bottom of the current document, CONTROL + END. 

 Move to the top of the current document, CONTROL + HOME. 

When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
  

1.3.2  Move between Help topics 

You can use the links at the top of each topic to go to the next or previous 

topic. 

To do this: 

1. Press CONTROL + HOME to move to the top of the document. 

2. Press TAB to move by link until you hear "Previous Topic Link" or "Next 

Topic Link". You can press SHIFT + TAB to move back to any links you 

may have skipped. 

3. Follow the link you have chosen by pressing ENTER. 

You can use the "Home" link to move to a page containing links to all topics 

relating to the current application. 

When you wish to return to your application, you can press ALT + F4 to 

close the Help window. 
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1.3.3  Switch between Help and your application 

You can remember your place in the SuperNova Help by keeping the 

SuperNova Help Browser window open. You may find it useful to switch 

between the SuperNova Help Browser window and your application 

window several times while carrying out help instructions. 

To do this: 

1. From the SuperNova Help window, press ALT + TAB to switch back to 

your application. 

2. Carry out any actions in your application. 

3. Press ALT + TAB to return to your position in the Help window. 

When you have finished using SuperNova help, you can press ALT + F4 to 

close the Help window. 
  

1.3.4  Add personal notes 

You can add personal notes in the SuperNova Help. You might do this to 

keep a note of certain hot keys or steps you need to follow to complete a 

task in an application. 

To do this: 

1. Run your application. 

2. Press CAPS LOCK + F1. 

The SuperNova Help menu opens. 

3. DOWN ARROW to “My Notes” and press ENTER. 

A blank document in NotePad or equivalent text editor opens. 

4. Add your text to the file. 

5. Save and close the file. 
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You can review and add to your notes by selecting the “My Notes” item in 

the SuperNova Help menu. The text files you create are saved in your 

¥Settings folder. 
  

1.4  Get Help from the SuperNova Control Panel 

Your SuperNova Control Panel provides two ways of getting help. 

 The Help button. 

 The Help menu. 
  

1.4.1  Use the Help Button 

The Help button in the SuperNova Control Panel is context sensitive.  

When you press this button, SuperNova opens the relevant section of the 

manual containing an explanation of the SuperNova settings in view. 

If the SuperNova Control Panel is not open, you can open it using LEFT 

CONTROL + SPACEBAR. 

You can press the Help button in any of these ways: 

 Left clicking the "Help" button on the Control Panel with the mouse. 

 TAB to the "Help" button and press SPACEBAR. 

 Press F1. 
  

1.4.2  Explore the Help menu 

The Help menu provides access to the complete SuperNova manual. The 

complete manual is particularly useful when you need to lookup a particular 

piece of information. 

1. If the SuperNova control panel is not open, you can open it using LEFT 

CONTROL + SPACEBAR. 
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2. When in the SuperNova control panel, press ALT + H to open the 

"Help" menu. The first item in the menu is "SuperNova Manual". 

3. Press ENTER to open the SuperNova manual. 

Use the following keys to navigate the SuperNova manual: 

 Choose a section, UP and DOWN ARROW Keys. 

 Expand and collapse individual sections, RIGHT and LEFT ARROW 

Keys. 

 Open a topic, ENTER. 

 Move between the contents and the open topic, F6. 
  

1.5  Get support for SuperNova 

1.5.1  Find help on the Dolphin website 

The Dolphin website offers a comprehensive range of support materials to 

help you get the most out of your Dolphin product. A variety of 

documentation is available, from handy tips and tutorials, to more technical 

knowledge base articles offering solutions to less common problems.  

To do this: 

1. Open a web browser and visit http://www.YourDolphin.com. 

2. Choose the "Support" link from the main navigation menu. 

3. Choose one of the options available to you: 

 Manuals and user guides. Dolphin's training Manuals and Quick Start 

Guides will help you get to grips with our products quickly and easily. 

 Tips & Tutorials. Handy step by step online tutorials covering the main 

product features. 



 

How to find help 11 

 

 Knowledge Base. The Knowledge Base is a searchable database 

containing a wealth of information and solutions to issues you might 

have with your Dolphin product. 
  

1.5.2  Contact your Dolphin Dealer for support 

If you purchased your Dolphin software from a registered Dolphin dealer, 

you can contact the dealer directly to receive the most appropriate localised 

support. If you do not know the contact details for your dealer, you can 

obtain these from the Dolphin website. 

To do this: 

1. Open a web browser and visit http://www.YourDolphin.com. 

2. Choose the "Dealers" link from the main navigation menu. This will 

open the "Dealer Locator" page. 

3. Select your country from the list then choose the "Submit" button. This 

will open a page displaying a list of Dolphin Dealers for that country. 

4. Review the results to locate the contact details for the dealer from which 

you purchased your Dolphin product. 
  

1.5.3  Contact Dolphin UK Product Support 

At Dolphin we pride ourselves in the quality and level of Product Support 

we provide to all our customers. Our goal is to continue to provide Product 

Support that is second to none. You can contact our Product Support team 

in a number of ways. 

To do this: 

 By telephone: +44 (0)1905 754765. 

 By telephone (UK Local Rate): 0345 130 5454. 

 By Fax: +44 (0) 1905 754 559. 

 By Email: support@yourdolphin.com. 
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1.5.4  Contact Dolphin USA Product Support 

At Dolphin we pride ourselves in the quality and level of Product Support 

we provide to all our customers. Our goal is to continue to provide Product 

Support that is second to none. You can contact our Product Support team 

in a number of ways. 

To do this: 

 By telephone (Toll free): 888 519 4694 

 By telephone (International): +1 609 803 2173. 

 By Email: support@dolphinusa.com. 
  

1.5.5  Find your product version number and your product serial 
number 

In the SuperNova "About" dialog box you can find information about: 

 Your SuperNova version number. 

 Your personal SuperNova serial number. 

 A copy of the SuperNova software license agreement. 

To open this dialog box: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

2. Press ALT + H. This will open the "Help" menu. 

3. DOWN ARROW to "About" and press ENTER. This will open the 

"About" dialog box. 
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1.5.6  Get further product training 

Dolphin has a network of approved trainers who are available to offer you 

high quality training either within your home or in your place of work. Our 

trainers can personalise the training to your individual requirements 

allowing you to maximise your independence, whilst taking into account 

your level of technical knowledge. You can contact Dolphin to find a 

Dolphin approved trainer in your area. 

To do this: 

 By telephone: +44 (0)1905 754577. 

 By Email: info@dolphinuk.co.uk. 
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C H A P T E R  2  

Install and Set Up 

2.1  Start SuperNova 

SuperNova will start automatically after you log onto your computer unless 

you have stated otherwise during the installation process. 

You can manually start SuperNova after log on by using the SuperNova 

shortcut key. 

Press CONTROL + SHIFT + S. 

If you have installed a new version alongside your existing version then the 

new version will be automatically given the following shortcut key: 

Press CONTROL + SHIFT + D. 

You can also launch SuperNova by selecting the SuperNova shortcut in the 

Windows Start menu. This is in the Programs, Dolphin sub-menu. 
  

2.2  Run SuperNova for the first time 

You will be guided through the activation process the first time you run 

SuperNova after installation. 

The activation process will guide you through unlocking and activating your 

software. 
  

2.3  Quit SuperNova 

To quit SuperNova: 

1. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 
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2. Press ALT + F. This will open the "File" menu. 

3. DOWN ARROW to "Quit SuperNova" and press ENTER. A message 

window will appear asking you to confirm you want to quit. 

4. TAB to the "Yes" button and press SPACEBAR. 
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C H A P T E R  3  

SuperNova Control Panel 

3.1  Introducing the SuperNova Control Panel 

 
  

The SuperNova Control Panel is the place that contains all of the settings 

for SuperNova. 

You can find SuperNova's settings in the Control Panel's menu bar and the 

button bar. 

The menu bar, which is the horizontal bar positioned below the title bar 

containing options to drop down menus, provides access to all the settings 

available in SuperNova. The button bar, which is positioned below the 

menu bar and contains large easy to access buttons, provides access to 

SuperNova's most commonly used settings. 

The final part of the SuperNova Control Panel is the status bar. The status 

bar, which is the horizontal bar at the bottom of the SuperNova Control 

Panel, provides information about the Settings files you are using. 
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You can switch from a full-sized to a compact version of the control panel 

using the restore down and maximise buttons in the title bar of the control 

panel. 
  

You can open the SuperNova Control Panel in several ways.  Use the one 

which suits you best. 

To open the SuperNova main Control Panel: 

Press LEFT CONTROL + SPACEBAR. 

This opens the full Control Panel as a dialog box. 

Alternatively, using the mouse, to open the SuperNova Control 

Panel: 

Click the SuperNova icon in the Windows Notification Area. 

To open the SuperNova Control Panel as a simple menu: 

Press CAPS LOCK + SPACEBAR or RIGHT CLICK the SuperNova 

icon in the Windows Notification Area. 
  

 
  

3.2  Keyboard commands to get around the SuperNova 
Control Panel 

The following tables provide a list of keyboard commands to help you get 

around the SuperNova Control Panel. Note that these keyboard commands 

are also standard Windows commands that you can use throughout 

Windows. 
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Keyboard Commands for the menu bar. 

Function Hot key 

Move focus to the menu bar ALT 

Move focus across the menu bar LEFT ARROW or 

RIGHT ARROW 

Open the menu item that has 

focus 

DOWN ARROW or 

ENTER 

Move to and open a menu bar 

item 

ALT + Underlined letter 

Move through an open menu DOWN ARROW or UP 

ARROW 

Open a submenu RIGHT ARROW or 

ENTER 

Close a submenu LEFT ARROW or 

ESCAPE 

Select a menu item ENTER 

 

Keyboard Commands for dialog boxes 

Function Hot key 

Move to the next control TAB 

Move to the previous control SHIFT + TAB 

Press a button, toggle a check 

box or select an option 

SPACEBAR 

Move directly to a control ALT + Underlined letter 

Open the next tab in a multi tab 

dialog box 

CONTROL + TAB 

Open the previous tab in a multi 

tab dialog box 

CONTROL + SHIFT + 

TAB 

Cancel ESCAPE 
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3.3  Settings in the SuperNova Control Panel 

All the SuperNova options can be accessed through the menus in the 

SuperNova Control Panel.  The following list summarises the purpose of 

the menus. 

 File menu: 

The "File" menu contains options for selecting your user profile as 

well as managing your SuperNova Settings files. This includes 

creating, editing, importing and exporting settings files. The "File" 

menu also contains the command to quit SuperNova. 
  

 Visual menu. 

The "Visual" menu contains the options to control magnification, 

screen colours, highlighting and other visual effects. You can also 

access many of these settings through the SuperNova button bar. 
  

 Media menu. 

The "Media" menu contains options for scanning, searching for 

books, reading online news articles, listening to radio stations and 

playing podcasts. 
  

 General menu. 

The "General" menu contains options that control SuperNova's 

behaviour including startup preferences, update settings, Control 

Panel appearance and SuperNova keyboard and hot key 

assignments. 
  

 Help menu. 

The "Help" menu provides shortcuts to useful resources including 

the SuperNova Manual, online resources and the "About" option. 

The "About" option provides you with your customer ID number 

plus the edition, version and build of SuperNova you are currently 

running. Ensure you have this information at hand if you require 

technical assistance. 
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3.4  Change the appearance of the SuperNova Control Panel 

You can make many changes to the SuperNova Control Panel. For 

example, you can hide the button bar, hide the status bar, stop the Control 

Panel appearing when you run SuperNova and remove it from the 

Windows Taskbar. 

For information about changing the SuperNova Control Panel, see the 

"General Control Panel dialog box". 
  

3.5  Close the SuperNova control panel 

You can close the SuperNova Control Panel in several ways. 

To do this: 

Press ESCAPE. 

Or, 

Click the minimise icon in the SuperNova Control Panel title bar. 

When you do this, the SuperNova Control Panel disappears and the focus 

goes back to the application you were previously running. SuperNova 

continues to run. 

NOTE: If you press ALT + F4 or click the close button in the 

SuperNova Control Panel title bar, then SuperNova will assume you 

want to quit the program. Before quitting, a message window 

appears asking you to confirm the action. 
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C H A P T E R  4  

Magnifier 

4.1  Turn magnification on or off 

 

You can turn on or off magnification using the "Visual" options in the 

SuperNova control panel or by using hot keys. If you are using a 

touchscreen device, you can also turn magnification on or off by doing a 3 

finger  double tap. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn off or on magnification LEFT 

CONTROL + 

NUMPAD 

ENTER 

ALT + 0 

 

If you're using multiple monitors and have the "Allow different magnification 

levels on each monitor" check box enabled in SuperNova's "Multiple 

Monitors" settings dialog box, then when you press the magnification on/off 

hot key it will turn the magnification on or off only on the monitor that your 

mouse pointer is currently on. 
  

4.2  Change magnification size 
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You can change the power of magnification from 1.2x to 64x. You can 

change the magnification size using the "Visual" options in the SuperNova 

control panel or by using hot keys. If you are using a touchscreen device, 

you can also change magnification by doing a 2 finger pinch or 2 finger 

stretch. 

Magnifier Hot Keys 

Function Desktop Hot 
Keys 

Laptop - 
Universal Set 

Increase magnification LEFT 

CONTROL + 

NUMPAD 

PLUS  

or  

CAPS LOCK + 

MOUSE 

WHEEL UP 

ALT + 

EQUALS 

or 

CAPS LOCK + 

MOUSE 

WHEEL UP 

Reduce magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or 

CAPS LOCK + 

MOUSE 

WHEEL 

DOWN 

ALT + DASH 

or 

CAPS LOCK + 

MOUSE 

WHEEL 

DOWN 

 

If you're using multiple monitors and have the "Allow different magnification 

levels on each monitor" check box enabled in SuperNova's "Multiple 

Monitors" settings dialog box, then when you press the increase or 

decrease magnification hot keys it will increase or decrease the 

magnification only on the monitor that your mouse pointer is currently on. 
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4.3  Change Magnifier view 

 

You can choose different ways to view the screen using the SuperNova 

Magnifier.  This includes the following viewing options: 

 Full Screen. 

This view fills the screen with a magnified portion of the "real" 

Windows screen. 

 Fixed Window. 

This view shows the magnified region of the screen in a small static 

window. You can change the size and position of the window. 

 Magnifying Glass 

This view behaves like holding a magnifying glass to the screen. You 

view the magnified region of the screen in a small moving window. 

You can change the size and position of the window. 

 Resizing Glass 

This view behaves similar to the Magnifying Glass except that the 

magnified window will automatically resize itself to the size of the 

current focus. This view is useful if you use the keyboard to navigate 

Windows and feel more comfortable seeing the unmagnified screen in 

the background. 

 Split Screen. 

This view splits the screen into two regions: a magnified window and 

an unmagnified window. You can choose where the magnified window 

appears and the size of the magnified window. The border between 

the magnified and unmagnified screen is shown as a black line. This 

mode is popular when also using an integrated CCTV package. 

You can change your viewing style by using the "Visual" options in the 

SuperNova control panel or by using hot keys. 

Magnifier Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Change Magnifier view LEFT 

CONTROL + 

NUMPAD 7 

ALT + SHIFT + 

M 

Change orientation when in 

Split Screen view 

LEFT 

CONTROL + 

NUMPAD 1 

No Assignment 

Note that you can change the size and colour of the border around the 

Fixed Window, Magnifying Glass, Resizing Glass and Split Screen views. 

You make this change in the "Visual Advanced Options" dialog box. 
  

4.4  Change size and position of the magnified window 

You can change the size and position of the Fixed Window, Magnifying 

Glass and Split Screen window. You make the change using a 

magnification modification mode. 

To adjust the size and position of the Fixed Window view: 

1. Choose "Fixed Window" as the Magnifier View setting. 

2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 

to enter magnification modification mode. If using the Laptop Hot Key 

set, press RIGHT CONTROL + F3 to enter magnification modification 

mode. 

In magnification modification mode, a flashing border indicates the 

object you are editing. 

3. Use the Arrow Keys to position the window on the screen. You can also 

do this by holding down the Z key and move the mouse. 

4. Press LEFT CONTROL + Arrow Keys to adjust the size of the window. 

You can also do this by holding down the X key and move the mouse. 

5. Press ESCAPE to exit magnification modification mode. 

To adjust the size of the Magnifying Glass view: 
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1. Choose "Magnifying Glass" as the Magnifier View setting. 

2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 

to enter magnification modification mode. If using the Laptop Hot Key 

set, press RIGHT CONTROL + F3 to enter magnification modification 

mode. 

In magnification modification mode, a flashing border indicates the 

object you are editing. 

3. Press LEFT CONTROL + Arrow Keys to adjust the size of the window. 

You can also do this by holding down the X key and move the mouse. 

4. Press ESCAPE to exit magnification modification mode. 

To adjust the size of the Split Screen view: 

1. Choose the Split Screen orientation that you are going to use as the 

Magnifier View setting. 

2. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 

to enter magnification modification mode. If using the Laptop Hot Key 

set, press RIGHT CONTROL + F3 to enter magnification modification 

mode. 

In magnification modification mode, a flashing border indicates the 

object you are editing. 

3. Press LEFT CONTROL + Arrow Keys to adjust the size of the window. 

You can also do this by holding down the Z key and move the mouse. 

4. Press ESCAPE to exit magnification modification mode. 
  

4.5  View other parts of the screen 

Only one part of the screen is visible when using magnification. To view the 

other parts of the screen, you can move the mouse pointer around the 

screen or use SuperNova hot keys. 

Moving around the screen using SuperNova hot keys is described as either 

panning, moving, move to or jumping. 
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 Panning. 

Panning moves the magnified area across the screen at a constant 

speed in the direction you specify. The speed of movement can be 

increased or slowed depending on the keys pressed. 

To pan across the screen press RIGHT CONTROL plus an Arrow 

Key. Hold down RIGHT CONTROL to keep panning. Press the same 

Arrow Key repeatedly (keeping RIGHT CONTROL pressed) to speed 

up the panning. Press the opposite Arrow Key to slow down.  

Use the other Arrow Keys to change direction. Release RIGHT 

CONTROL to stop panning. 

 Moving (accelerated panning). 

Moving works in a similar way to panning, except that the speed of 

the panning will automatically accelerate up to a certain top speed 

whilst you have the keys held down. 

To move the magnified area press and hold down RIGHT CONTROL 

+ RIGHT SHIFT together with an Arrow Key. When you let go, 

moving will stop. 

 Move To. 

You can also move the magnified area directly to various parts of the 

screen. The following table lists the hot keys that will allow you to 

move the magnified area to a screen position. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Top left RIGHT 

CONTROL + 

NUMPAD 7 

No 

Assignment 

Top RIGHT 

CONTROL + 

NUMPAD 8 

No 

Assignment 
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Top right RIGHT 

CONTROL + 

NUMPAD 9 

No 

Assignment 

Left RIGHT 

CONTROL + 

NUMPAD 4 

No 

Assignment 

Centre RIGHT 

CONTROL + 

NUMPAD 5 

No 

Assignment 

Right RIGHT 

CONTROL + 

NUMPAD 6 

No 

Assignment 

Bottom left RIGHT 

CONTROL + 

NUMPAD 1 

No 

Assignment 

Bottom RIGHT 

CONTROL + 

NUMPAD 2 

No 

Assignment 

Bottom right RIGHT 

CONTROL + 

NUMPAD 3 

No 

Assignment 

  

 Jump Movement. 

Movement around the screen is also possible in steps. This is 

different to panning as the magnified window does not scroll smoothly 

but rather moves in steps.  

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Up LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 8 

RIGHT 

CONTROL + 

RIGHT SHIFT 

+ UP ARROW 
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Down LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 2 

RIGHT 

CONTROL + 

RIGHT SHIFT 

+ DOWN 

ARROW 

Left LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 4 

RIGHT 

CONTROL + 

RIGHT SHIFT 

+ LEFT 

ARROW 

Right LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 6 

RIGHT 

CONTROL + 

RIGHT SHIFT 

+ RIGHT 

ARROW 

Save and Restore Screen Position 

Also available is the opportunity to save a screen position. This will then 

allow you to return to the same position with the press of a hot key. 

To save a screen position: 

1. Move the magnified window to the required position. 

2. Press RIGHT CONTROL + NUMPAD 0 to save the position. 

To move the magnified window back to the saved position: 

Press RIGHT CONTROL + NUMPAD PERIOD to return to the saved 

screen position. 
  

4.6  Get an overview of the magnified window position 

You can see the position the magnified window is on the screen by using 

Magnifier Overview. You switch in and out of Magnifier Overview using a 

SuperNova hot key. 

To enter and exit Magnifier Overview: 
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Press LEFT CONTROL+ BACKSLASH. 
  

4.7  Create static magnified windows to display information 

You can create static magnified windows to keep a particular area of the 

screen permanently displayed. This lets you see important information that 

may frequently change as you use your application.  

SuperNova calls these windows "Hooked Areas". Hooked Areas can have 

their own magnification size and will be visible even if you turn off the 

SuperNova Magnifier. 

Examples: 

 You can hook the system tray clock to make it easy to see the time. 

 You can hook the place on a word processor's status bar that reports 

the current page number to make it easy to see what page you are 

currently working on. 

 You can hook the Formula Bar in a spreadsheet to make it easy to 

see if the current cell contains a formula or text. 

You can create a Hooked Area by using the mouse pointer or by using the 

keyboard. 
  

4.7.1  Create a Hooked Area using the keyboard 

To create and change the position and size of a Hooked Area window 

using hot keys requires the use of magnification modification mode. 

To create and adjust the size and position of a Hooked Area: 

1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 5 

to create a new Hooked Area and automatically enter magnification 

modification mode. If using the Laptop Hot Key set, press LEFT 

CONTROL + LEFT SHIFT + ALT + H to create a new Hooked Area and 

automatically enter Magnification Modification Mode 
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In magnification modification mode, a flashing border indicates the 

object you are editing. 

2. Use the Magnifier hot keys to change the size of the content inside the 

Hooked Area. 

3. Use the Arrow Keys to position the window on the screen. You can also 

do this by holding down the Z key and move the mouse. 

4. Press LEFT SHIFT + Arrow Keys to alter the content inside the Hooked 

Area. You can also do this by holding down the C key and move the 

mouse. 

5. Press LEFT CONTROL + Arrow Keys to adjust the size of the window. 

You can also do this by holding down the X key and move the mouse. 

6. Press ESCAPE to exit magnification modification mode. 

During the creation process you will probably find it is only through 

repeated adjustment of size, position and content within the Hooked Area 

do you get the desired result. 
  

4.7.2  Modify a Hooked Area using the keyboard 

To modify an existing hooked area: 

1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 6. 

If using the Laptop Hot Key set, press LEFT CONTROL + F6. This will 

enter magnification modification mode with the currently selected 

Hooked Area identified by a flashing border. 

2. If you have multiple Hooked Areas then you can cycle between the 

Hooked Areas by pressing LEFT CONTROL + NUMPAD 6 if using the 

Desktop Hot Key set. Press LEFT CONTROL + F6 if using the Laptop 

Hot Key set. 

3. Use the available Magnifier hot keys and Magnification Modification 

Mode hot keys to adjust the size, location or content of the Hooked 

Area. 

4. Press ESCAPE to exit Magnification Modification Mode. 
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4.7.3  Delete a Hooked Area using the keyboard 

To delete an existing hooked area: 

1. If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 6. 

If using the Laptop Hot Key set, press LEFT CONTROL + F6. This will 

enter Magnification Modification Mode with the currently selected 

Hooked Area identified by a flashing border. 

2. If you have multiple Hooked Areas then you can cycle between the 

areas. To do this press LEFT CONTROL + NUMPAD 6 if using the 

Desktop Hot Key set. Press LEFT CONTROL + F6 if using the Laptop 

Hot Key set. 

3. Press DELETE to remove the Hooked Area. 

When the Hooked Area is deleted the focus will move to the next Hooked 

Area. If no Hooked Areas remain then Magnification Modification Mode will 

be automatically exited. If additional Hooked Areas remain that you do not 

want to modify then press ESCAPE. 
  

4.7.4  Create a Hooked Area using the mouse 

You can create Hooked Areas through the "Create Hooked Areas" dialog 

box. To open this dialog box, open the "Visual" menu and select the menu 

item "Advanced Options". Then in the "Hooked areas" property sheet of the 

Advanced Options dialog box press the "New" button. 

In the "Create Hooked Areas" dialog box you will need to: 

1. Provide a unique description for the hooked area. 

2. Select or unselect the "Track focus" check box. 

Track focus determines whether the content of the hooked area is 

fixed or shows the current focus. Select this check box and the 

contents of the hooked area will track the focus. If this check box is 
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selected then the "Choose screen area to hook" button will be 

disabled as an area of the screen is not being defined. 

3. Select the "Choose screen area to hook" button to define the screen 

area to display.  

4. Use LEFT MOUSE BUTTON with mouse movement to create a new 

area. Press ENTER or the RIGHT MOUSE BUTTON to accept, 

ESCAPE to cancel. 

5. Select or unselect the "Smoothing" check box. 

6. Select the "Move the hook window" button to position the hooked area 

and to set the magnification size. 

The magnification size can be set using the normal hot keys. Use 

mouse movement or the CURSOR KEYS to move the hook. Press 

ENTER or the LEFT MOUSE BUTTON to accept, ESCAPE to cancel. 

7. Select the "OK" button to confirm and save the new Hooked Area. 

You can view a list of your created Hooked Areas in the "Hooked Areas" 

tab, in the "Visual Advanced Options" dialog box. You can also sort, modify 

and delete existing Hooked Areas in the "Hooked Areas" tab. 
  

4.7.5  Show or hide Hooked Areas 

You can show or hide Hooked Areas using a SuperNova hot key. This can 

be useful if you do not want the Hooked Areas to be visible all the time but 

rather as and when information from other areas of the screen is required. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn off or on Hooked Areas LEFT 

CONTROL + 

NUMPAD 3 

LEFT 

CONTROL + 

F5 
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C H A P T E R  5  

Screen enhancements 

If you find it difficult to view the screen, track the focus or follow the mouse 

pointer then the visual enhancements available in SuperNova may provide 

you with a solution. 
  

5.1  Make the screen easier to see 

 

SuperNova contains options to make viewing the screen more comfortable. 

One of these options is SuperNova Colour Schemes, which can change the 

contrast, brightness and colours on the screen. 

You can choose a pre-set SuperNova Colour Scheme or create a custom 

scheme. A Colour Scheme is applied to the whole screen and will work 

even when the Magnifier is turned off. 

You can choose a Colour Scheme through the "Visual" options in the 

SuperNova control panel. You can  also toggle off or on a Colour Scheme 

using the "Visual" options in the SuperNova control panel or by using hot 

keys. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn on or off your Colour 

Scheme 

LEFT 

CONTROL + 

NUMPAD 0 

ALT + SHIFT + 

C 
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To create a custom scheme you must select "Custom" before you can 

choose "Configure..." from the list of Colour Schemes. Choosing 

"Configure..." opens the "Configure Custom Colour Scheme" dialog box. 

The dialog box contains different controls depending on the settings you 

choose. This includes brightness, contrast, tint and colour replacement 

settings. 

If you're using multiple monitors and have the "Independent colours" check 

box enabled in SuperNova's "Multiple Monitors" settings dialog box, then 

when you press the Colour Scheme on/off hot key it will turn the Colour 

Scheme on or off only on the monitor that your mouse pointer is currently 

on. 
  

5.2  Make the focus easier to see 

 

SuperNova contains options to make viewing the screen more comfortable. 

One of these options is SuperNova Highlighting, which makes different 

types of focus easier to see by attaching a visual marker to the focus. 

Types of focus include: 

 Mouse (the pointer controlled by the mouse). 

 Cursor (the beam cursor used in edit areas). 

 Line (the line the beam cursor is positioned). 

 Focus (the focus in dialog boxes and menus). 

You can choose a pre-set SuperNova Highlighting Scheme or create your 

own personal custom scheme. You choose a scheme through the "Visual" 

options in the SuperNova control panel. 

To create a custom scheme you must select "Settings". from the list of 

Highlighting Schemes. When you choose "Settings" SuperNova 
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automatically switches to the "Custom" scheme before opening the 

Highlighting Options dialog box. SuperNova also uses the previous 

scheme's values to make the default values for the new custom scheme. 

Tip: If you see no visual effect when choosing a scheme then check 

to ensure "Highlighting" is turned on. You can turn Highlighting on by 

selecting the "Highlighting" option in the "Visual" menu or by 

selecting the "Highlighting" button in the "Visual" tab of the 

SuperNova control panel. 

  

5.3  Make the pointer easier to see 

 

SuperNova contains options to make viewing the screen more comfortable. 

One of these options is SuperNova Mouse Pointers, which allows you to 

change the size and colour of the pointer on the screen.  

You can choose a pre-set SuperNova Mouse Pointer scheme or create 

your own personal custom scheme through the "Visual" options in the 

SuperNova control panel. 

The pre-set schemes include: 

 Large Red 

 Large White 

 Large Yellow 

The selecting of the "Windows Standard" scheme will change the pointer 

scheme back to the Windows defaults. 
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C H A P T E R  6  

Line View 

 

Line View is a SuperNova reading mode. Line View shows the content of 

the screen as a single line scrolling across the screen. You can control the 

size, colours, font and the speed and position of the scrolling text. 
  

6.1  Start Line View 

You can start Line View from the "Visual" options in the SuperNova control 

panel or by using a hot key. Line View can start at the current focus 

position or it can ignore the current focus in favour of displaying the current 

window or screen. 

Line View Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Start Line View (restricted to 

document window) 

LEFT 

CONTROL + 

NUMPAD 

PERIOD 

No 

Assignment 

Start Line View (restricted to 

whole window) 

LEFT 

CONTROL + 

NUMPAD 9 

No 

Assignment 

Start Line View at current 

focus position (restricted to 

document window) 

LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 2 

ALT + SHIFT 

+ L 
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Start Line View at current 

focus position (restricted to 

whole window) 

LEFT 

CONTROL + 

NUMPAD 2 

ALT + SHIFT 

+ V 

 
  

6.2  Scroll text in Line View 

You use various hot keys to control how the content scrolls in Line View. 

Line View Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Go to the Focus NUMPAD 0 F5 

Start and Stop SPACEBAR SPACEBAR 

Go to the First line HOME HOME 

Go to the Last Line END END 

Previous Line PAGE UP PAGE UP 

Next Line PAGE DOWN PAGE DOWN 

Scroll Faster UP ARROW UP ARROW 

Scroll Slower DOWN 

ARROW 

DOWN 

ARROW 

Flip forward ENTER ENTER 

Move Forward RIGHT 

ARROW 

RIGHT 

ARROW 

Move Backwards LEFT ARROW LEFT ARROW 

Exit Line View mode ESCAPE ESCAPE 

Tip: Line View mode is restricted to what is visible on the screen. In some 

applications it is possible to change the application's view settings to 

increase the data visible at any one time. For example, in Microsoft Word 

Print Preview it is possible to set the page view to a maximum of 6 pages. 

All 6 pages will be scrolled in Line View mode. 
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6.3  Change the colour, font and items displayed in Line View 

You can change the colours, fonts, objects and the size of the text shown in 

Line View. 

To go to the Line View options: 

1. Press Left control + SPACEBAR. This will open the SuperNova control 

panel. 

2. Press ALT + V. This will open the "Visual" menu. 

3. DOWN ARROW to "Advanced Options" and press ENTER. This will 

open the "Visual Advanced Options" dialog box. 

4. CONTROL + TAB to open the "Line View " tab. 

5. Make your changes. 

6. TAB to the "OK" button and press SPACEBAR. This will confirm your 

changes and close the dialog box. 
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C H A P T E R  7  

Doc Reader 

 

The Doc Reader lets you create your own reading environment, where the 

text, background and highlight can all be set to a value that makes reading 

comfortable for you. You can display text from documents, web pages or 

any other source showing text on the screen. 
  

7.1  Launch Doc Reader 

You can launch the Doc Reader by clicking the Doc Reader button on the 

"Visual" page of the SuperNova control panel or by pressing a SuperNova 

hot key. 

Doc Reader Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Launch Doc Reader CAPS LOCK + 

NUMPAD 

PLUS 

ALT + SHIFT 

+ D 

Your text will be loaded into the Doc Reader. This may take a few seconds. 

In the Doc Reader, you can use the Arrow Keys to move the highlight 

through the text or press TAB to move through the Doc Reader toolbar 

options. 
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7.2  Control reading 

The items available on the Doc Reader toolbar control the reading 

environment. For advanced controls, including the colour settings, fonts 

and reading speed please go to the "Doc Reader Settings" dialog box. 

After launching the Doc Reader, you can access the toolbar options by 

pressing TAB. Repeated presses of TAB will move you along the toolbar 

options and finally return you to the document window.  You can also use 

SHIFT + TAB to navigate back across the toolbar buttons. 

Doc Reader toolbar. 

 

You press this button to start or stop the reading of the document. You can 

also start or stop the reading of the document by pressing SPACEBAR. 

When reading, the Doc Reader highlights the current word and 

automatically scrolls the document window. 

 

You press this button to increase the size of the text. The change in the text 

size is independent from the custom font options in the Doc Reader 

Settings dialog box. 
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You press this button to shrink the size of the text. The change in the text 

size is independent from the custom font options in the Doc Reader 

Settings dialog box. 

 

You press this button to cycle through the highlighting options, where you 

can cycle between line, sentence and paragraph highlighting.  The item 

selected determines what is highlighted as a "unit" and the size of 

movement as you navigate up and down through your text. 

 

You press this button to cycle through a number of different colour 

schemes. This is helpful if you find viewing the on screen document text 

difficult because of screen colours and contrast. 

 

You press this button to open the "Mode" menu, where you can choose 

between different viewing mode options such as "Word Wrap" and "Single 

Line". 
  

7.3  Exit Doc Reader 

To do this: 

Press ESCAPE. 
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C H A P T E R  8  

Guest Mode and Emergency Mode 

The USB edition of SuperNova contains a special feature called Guest 

Mode. Guest Mode allows your USB edition to operate in environments 

where you don't have Administrator access on the computer, such as 

public libraries and hotel business centres. 

 

Startup 

To start your USB edition of SuperNova run the program Go.exe (located in 

the root folder of your USB drive). 

If you've previously installed the additional SuperNova USB components 

onto the computer then your USB edition is likely to auto-start when you 

insert it. 

If you insert your USB edition on a computer that has an existing copy of 

SuperNova already installed that's the same version (or higher) as your 

USB edition, or a computer that you have previously installed the additional 

USB components onto, then you will not have the Guest Mode option. 

Instead your USB edition will run in Normal Mode. 

When you start your USB edition of SuperNova on a new computer, or a 

computer without any additional components installed, you'll receive a 

dialog box with two options: 

 Continue in Guest Mode 

or 

 Install components and restart 
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If you choose the install components option a Windows' User Account 

Control dialog will appear requesting Administrator permissions. If you 

select "Yes" then the additional components will be installed. For Windows 

7 the computer will then be restarted. For Windows 8 and Windows 10 only 

SuperNova will restart and it should then run in Normal Mode. 

 

9.1  Limitations of Guest Mode 

 Magnification will not pan around quite as smoothly as in Normal 

Mode. The computer's CPU and GPU usage may also be a little 

higher than in Normal Mode even when doing nothing. Magnification 

may also be not as smooth if you have more than one monitor in use. 

 The Connect and View video stream is unlikely to update faster than 

30 frames per second. 

 Custom mouse pointers won't work. You can try to use the Windows 

control panel to set a custom mouse pointer, but this may also not 

work if you choose one of SuperNova’s custom mouse pointers (due 

to a bug in Windows). 

 There's no speech and magnification support at the Windows logon 

screen. (You can use Windows Narrator and/or Windows Magnifier 

here instead). 

 Windows' User Account Control dialog boxes will not magnify or 

speak. 

 Any application that runs as Administrator may not be accessible and 

may cause other problems, notably no SuperNova hot keys will work 

and you'll receive limited or no speech and braille output. This could 

also prevent the user interface in Connect and View and Line View 

Mode from working. If you get stuck in this scenario press ALT+TAB 

to switch away from the application. 

 The Internet Updater will continue to work for maps and scripts, but 

will not download product updates. 
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 Modern Windows 8/10 apps should speak and braille just as well as in 

Normal Mode. However, the image smoothing of magnified text may 

not work. 

 Pressing PRINT SCREEN or ALT+PRINT SCREEN will capture the 

magnified screen or the area of the magnified screen where the 

window would be if it wasn't magnified (respectively). To capture 

unmagnified screens toggle magnification off before pressing PRINT 

SCREEN.. 

 TeamViewer remote control sessions will capture the magnified 

screen not the unmagnified screen. 

 SuperNova's touch screen gestures will not work. 

 SuperNova's OCR features may not work. 

Please refer to the Dolphin web site for any other caveats. 

 

Emergency Mode 

If you run a copy of SuperNova that was installed on the computer's local 

hard disk, but some components are missing, then SuperNova will start up 

in Emergency Mode and you'll receive a dialog box with two options: 

 Continue in Emergency Mode 

or 

 Install components and reboot 

If you choose the install components and reboot option a Windows' User 

Account Control dialog will appear requesting Administrator permissions. If 

you select "Yes" then the additional components will be installed and the 

computer will be rebooted. 

Emergency Mode is functionally equivalent to Guest Mode. Please see the 

limitations listed above for further details. 
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Note: Currently Guest Mode and Emergency Mode are only 

available on Windows version 10 (and below). 

 



 

 53 

 

C H A P T E R  9  

Settings Files 

10.1  Create Application Settings 

If you find you regularly adjust SuperNova output settings when working in 

different programs, then using Application Settings can provide an 

automated solution. 

To create an Application Settings file: 

1. Run the application you want to create an Application settings file for. 

2. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

3. Press ALT + F. This will open the "File" menu with "New" selected. 

4. RIGHT ARROW into the "New" sub-menu. 

5. Select "Application settings" and press ENTER. This will open the 

"Select Settings file" dialog box. 

6. Select "Create a new settings file". 

7. TAB to the "OK" button and press SPACEBAR. This will open the 

"Create new Settings File" dialog box. 

8. Give the new Application Settings file a name, choose whether to create 

an empty settings file or copy an existing settings file and then TAB to 

the "OK" button and press SPACEBAR. This will close the dialog box 

and return you to the SuperNova control panel. 

Your Application Settings file will now be in use. You can check the 

Application Settings file currently in use by reading the Status Bar in the 

SuperNova control panel. 
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10.2  Create Situation Settings 

If you find you regularly adjust SuperNova output settings when certain 

dialog boxes appear in an application then using Situation Settings can 

provide an automated solution. Situation Settings are a subset of 

Application Settings and are stored within the same file. 

To create a Situation Setting: 

1. Run the application and get into the situation you want to create a 

Situation Setting for. 

2. Press LEFT CONTROL + SPACEBAR. This will open the SuperNova 

control panel. 

3. Press ALT + F. This will open the "File" menu with "New" selected. 

4. RIGHT ARROW into the "New" sub-menu. 

5. Select "Situation settings" and press ENTER. This will open the "New 

Situation Settings" dialog box. 

6. Select "Create new Situation". 

7. TAB to the "OK" button and press SPACEBAR. This will open the 

"Enter a name for the new Situation" dialog box. 

8. Give the new Situation Setting a name and then TAB to the "OK" button 

and press SPACEBAR. This will open the "Windows Name" dialog box. 

9. If required, adjust the Window Name and then TAB to the "OK" button 

and press SPACEBAR. This will close the dialog box and return you t 

the SuperNova control panel. 

Your Situation Setting will now be in use. You can check the Situation 

Setting currently in use by reading the Status Bar in the SuperNova control 

panel. 
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10.3  Save setting changes 

SuperNova automatically saves the changes you make to SuperNova 

settings.  

To stop this behaviour, deselect the "Always save user settings" check box. 

You can find the "Always save user settings" check box in the "Startup 

Preferences" dialog box, which you open through the "General" menu of 

the SuperNova control panel. 

After deselecting the "Always save user settings" check box, an additional 

"Ask user" check box becomes available. If you select this check box then 

you will receive a message window during the quitting of SuperNova that 

asks if you want to proceed without saving the changes you have made. 

You can also manually save settings at any time by choosing the "Save 

Settings" menu item. You can find this item in the "File" menu in the 

SuperNova control panel. 
  

10.4  Change Map file 

If you are using an application that does not have a specific Map file then 

SuperNova will use the "Default Application" Map file. 

If you find SuperNova does not work well with your application using the 

"Default Application" Map file then it is worth trying another Map file. You 

can try as many Map files as you like. 

Tips: 

 Try using a Map file for a different version of the same application. 

You may find a Map file for an old version of an application will work 

just as well with a new version of the application. 

 Try using a Map file created for an application from the same 

manufacturer. You may find a Map file for a different application but 

created by the same manufacturer will work well with your application, 
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for example, if you are using a Microsoft application try using the 

Microsoft Office Map file. 

 Try using the "MSAA Application" Map file if you know your application 

supports MSAA. 

To choose a different Map file: 

1. Run your application. 

2. Press LEFT CONTROL + SPACEBAR. 

The SuperNova control panel opens. 

3. Press ALT + F. 

The "File" menu opens with the "New" menu item selected. 

4. RIGHT ARROW to open the "New" sub-menu, DOWN ARROW to 

"Map" and press ENTER. 

The "Select Map file" dialog box opens. 

5. DOWN ARROW to select the "Use an existing Map file" option. 

6. TAB to the Map list and use the Arrow Keys to select a Map file. 

7. TAB to the "OK" button and press SPACEBAR. 

The dialog box closes. 

8. Press ESCAPE. 

The SuperNova control panel closes and you go back to the 

application. 

The new Map file's detection settings will take effect immediately. If you 

continue to have problems accessing your application then please contact 

Dolphin or your local Dolphin Dealer for assistance. 

 

 



 

 57 

 

C H A P T E R  1 0  

Media 

You can use Media to search for and download books and magazines from 

online libraries and to browse news feeds, listen to radio stations and play 

popular podcasts. 

IMPORTANT: The options available in Media will differ depending 

on your SuperNova Control Panel language. 

  

11.1  Media Books 

You can use the "Books" option to search for, download and open books 

and magazines from online libraries. You can also use this option to open 

files on the computer. The books and files you select open in the 

SuperNova Reader. 
  

11.1.1  Open a file in the SuperNova Reader: 

You can use Media to open files on the computer. The file formats you can 

open include text files, ePub files, DAISY books, HTML files and PDF files. 

The files will open in the SuperNova Reader. 

To open a file from the SuperNova Control Panel: 

1. Open the "Media" option, select "Books" and choose "Open file in 

Reader". The "Open" dialog box opens. 

2. Select the file you want to open. If you are using the keyboard you can 

SHIFT + TAB into the file list, use the Arrow Keys to select the file and 

then press ENTER. If the file is in a different folder, use BACKSPACE 

to go one level up and use ENTER to open folders until you select the 

file and then press ENTER. 
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3. Select your conversion settings.  

4. When done, select the "OK" button. A message window opens showing 

the progress of the conversion. When the conversion is complete the 

book opens in the SuperNova Reader. 

5. When you have finished reading the text, press ALT + F4 to close the 

window. 
  

11.1.2  Open a book from an online library 

You can use Media to download and open books from online libraries. The 

files will open in the SuperNova Reader. 

To open a book from the SuperNova control panel: 

1. Open the "Media" option, select "Books" and choose "Online books". 

The Bookshelf dialog box opens showing a list of available libraries. 

Note that some libraries may require you to register with them before 

you can download a book. If you want to use the services of these 

libraries then you must first contact the library to register with them and 

obtain user account details. 

2. Select a library. Depending on the library, you will typically find a 

category list opens giving you further options to narrow down the list of 

books to be shown. This can sometimes be followed by a third and 

fourth list of subcategories. 

3. Browse the available categories and books. Alternatively, if you know 

the title of the book you want to read, type in a key word in the search 

box and press ENTER. SuperNova will search the library for matches 

and list the results. 

4. Select the book you want to read and choose the "Download" button. 

5. When the download is complete, do one of the following: 

If you want to read the book, select the "Read now" button. The book 

opens in the SuperNova Reader. When you have finished reading 

the text, press ALT + F4 to close the window. 
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If you want to copy the book to a portable device, ensure you have a 

portable device connected to the computer and select the "Send To" 

button. A dialog box opens listing the drives you can copy the book to. 

Select the drive and press ENTER. A confirmation message will 

appear when the process is complete. 

If you want to remove the book from the computer, select the "Delete" 

button. A message window opens asking you to confirm the action. 

Choose "Yes" to delete the book. 
  

11.1.3  Open the last book you were reading 

You can continue reading the last book you opened by opening the "Media" 

option, selecting "Books" and choosing "Continue reading...". The book 

opens in the SuperNova Reader. You will be positioned at the last place 

you were in the book. 
  

11.1.4  Open, copy or delete an existing book 

You can open, copy and delete books you download from online libraries. 

To do this from the  SuperNova control panel: 

1. Open the "Media" option, select "Books" and choose "My Books.. A list 

opens showing available books. 

2. Select the book you want to open, copy or delete. A dialog box opens. 

3. Do one of the following: 

If you want to read the book, select the "Read now" button. The book 

opens in the SuperNova Reader. When you have finished reading 

the text, press ALT + F4 to close the window. 

If you want to copy the book to a portable device, ensure you have a 

portable device connected to the computer and then select the "Send 

To" button. A dialog box opens listing the drives you can copy the 

book to. Select the drive and press ENTER. A confirmation message 

will appear when the process is complete. 
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If you want to remove the book from the computer, select the "Delete" 

button. A message window opens asking you to confirm the action. 

Choose "Yes" to delete the book. 
  

11.2  Media News, Radio Stations and Podcasts 

You can use Media's "News", "Radio Stations" and "Podcasts" to keep 

up-to-date with the latest news and entertainment available on the Internet. 

IMPORTANT: Some content requires RealPlayer to be installed. If 

you do not have support for this content then SuperNova displays a 

warning message. The message includes links to web sites where 

you can download the necessary files. 

  

11.2.1  Read a news article 

You can open, browse and read popular news articles available on the 

Internet using Media. 

To do this from the  SuperNova control panel: 

1. Open the "Media" option and select "News". A list of popular news 

feeds opens. 

2. Select a feed. If you do not find a feed you are interested in reading, 

select the "Add" button to explore other available feeds, which you can 

add to the Favourites list. 

3. Select a headline. The dialog box closes and the news article opens in 

the default web browser. 
  

11.2.2  Listen to a radio station 

You can listen to popular radio stations available on the Internet using 

Media. 

To do this from the  SuperNova control panel: 
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1. Open the "Media" option and select "Radio". A list of popular radio 

stations opens. 

2. If you do not find a radio station you are interested in listening to, select 

the "Add" button to explore other available radio stations, which you can 

add to the Favourites list. 

3. Select a radio station. The dialog box closes and the radio station 

begins to play in an associated media player, for example, Windows 

Media Player. 
  

11.2.3  Listen to a podcast 

You can listen to popular podcasts available on the Internet using Media. 

To do this from the  SuperNova control panel: 

1. Open the "Media" option and select "Podcasts". A list of popular 

podcasts opens. 

2. If you do not find a podcast you are interested in listening to, select the 

"Add" button to explore other available podcasts, which you can add to 

the Favourites list. 

3. Select a podcast and then choose an episode. The dialog box closes 

and the podcast begins to play in an associated media player, for 

example, Windows Media Player. 
  

11.2.4  Adjust the favourite news, radio station and podcast listings 

You can add, remove and organise the news, radio stations and podcast 

listings in Media. 

To do this from the  SuperNova control panel: 

1. Open the "Media" option and select the web service you want to modify. 

A list opens showing available services. 

2. Do one of the following: 
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To add a service, select the "Add" button. This opens a new dialog 

box containing a list of the services you can add and a list of the 

currently available services. Select a service to add and then choose 

the "Add" button. Repeat the steps for each service you want to add. 

To remove a service, select the service, then choose the "Remove" 

button. Repeat the steps for each service you want to remove. 

To organise the list of services, select a service and then choose the 

"Up" or "Down" button. This will move the item higher or lower down 

the list of services. Continue to press the button until you position the 

item in the list where you want it to be placed. 

3. When done, select the "Close" button. 
  

11.3  SuperNova Reader keyboard commands 

The books you open from the Bookshelf appear as an HTML page in the 

SuperNova Reader. This allows you to read and navigate the book in the 

same way you read web pages. 

In addition, SuperNova includes the following keyboard commands: 

Function Hot key 

Move between document 

window and toolbar 

F6 

Move between the buttons on 

the toolbar 

TAB and SHIFT + TAB 

Play / stop (only available if book 

has audio content) 

F5 

Open Content ALT + C 

Open Settings ALT + S 

Zoom In ALT + I 

Zoom Out ALT + O 

Exit ALT + E (or ALT + F4) 
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Connect and View 

 

SuperNova Connect and View lets you connect any high-definition (HD) 

camera to your computer and magnify items including newspapers, 

magazines, bills, labels and even objects onto your computer screen. 

You can also use SuperNova Connect and View to connect to other 

computers and view what is on their screen on your own computer screen. 

For example, you can connect to a teacher's interactive whiteboard or a 

trainer's computer and follow what they are presenting on your own 

computer screen. 
  

12.1  Camera Connect and View 

Camera Connect and View lets you connect any High-Definition (HD) 

Camera to your computer and magnify printed material and objects onto 

your computer screen. 

You can use any high-definition (HD) camera with SuperNova. For an 

official list of cameras that have been tested and are recommended by 

Dolphin, please visit the Dolphin web site or contact your local Dolphin 

dealer. 

Before you can use SuperNova Camera Connect and View you will need to 

acquire a suitable camera, setup your workstation and select the camera in 

SuperNova. 
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12.1.1  Acquiring a suitable camera and stand 

For best results you will need an HD camera with autofocus, delivering 

1080p video resolution with automatic low-light correction. This will require 

a USB 2.0 port connection to the computer. 

In addition to the camera, you should use a stand to hold the camera on 

the desk. The use of a stand makes sure the camera is secure and stable 

over the items you want to view. 
  

12.1.2  Setting up your workstation 

For best results, ensure you position the camera close to your computer 

screen to make it easy to adjust the items you want to view while still being 

able to view the computer screen. You should also make sure the camera 

is in a safe, clear, well lit area on your desk to avoid shadows falling across 

the items you want to view. 
  

12.1.3  Selecting the camera in SuperNova 

Once you have setup the camera on your desk and connected it to the 

computer, you must select the camera in the SuperNova "Connect and 

View Settings" dialog box. 

To do this in the SuperNova Control Panel: 

1. In the "Visual" option, open the "Connect and View" submenu and 

choose "Settings". The "Connect and View Settings" dialog box opens 

showing the "Camera" settings. 

2. Select your camera from the "Devices" list and choose the "OK" button. 

If your camera is not listed then ensure it is properly connected and 

switched on. 
  

12.1.4  Using your camera with SuperNova 

You can use the following options to enable, configure and adjust the 

camera image with SuperNova. 
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Switching on the Viewer 

After selecting the device in the "Connect and View Settings" dialog box, 

you can view its output by turning on "Connect and View". You can switch 

on or off "Connect and View" using the "Visual" options in the SuperNova 

control panel or by using a hot key. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Connect and View on off ALT + 

NUMPAD 

ENTER 

LEFT SHIFT + 

CAPS LOCK + 

0 

 

When you turn on "Connect and View" a portion of the screen begins to 

show the image from the camera or whiteboard. This area is called the 

Viewer. You can change the position of the Viewer on the screen and you 

can use the Viewer Toolbar to adjust the size, colour and contrast of the 

image to make it easier to see. 

 
  

Switching between the Viewer and the desktop 

To access the Viewer toolbar and to make adjustments to the image 

requires you to place the focus in the Viewer area. 

You can switch between the Viewer and the desktop by pressing CAPS 

LOCK + MIDDLE MOUSE BUTTON. If you have both an active camera 

and whiteboard connection then pressing CAPS LOCK + MIDDLE MOUSE 

BUTTON cycles you between camera, whiteboard and desktop. 
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Adjusting the Viewer position and size 

By default, the Viewer appears on the top half of the screen. You can 

change the position and size of the Viewer through the "Connect and View" 

settings in the SuperNova Control Panel. You can dock the viewer to the 

top, bottom, left or right side of the screen and the Viewer can be set to fill 

80%, 50% or 20% of the screen area. 

While in the Viewer window you can also press LEFT CONTROL + NUM 

PAD 7 on your keyboard to cycle you between split screen mode and full 

screen mode. 

You can also do this using the following buttons in the Viewer: 

 

 

 

While in Full Screen Mode, you can continue to use CAPS LOCK + 

MIDDLE MOUSE BUTTON to switch between the Viewer and the desktop. 
  

Showing and hiding the Viewer toolbar 

The Viewer Toolbar provides you with controls to modify the image you are 

viewing. The options available on the toolbar differ depending on whether 

you are connecting to a camera or connecting to a whiteboard. 

You can use the Show and Hide buttons to control the appearance of the 

Viewer Toolbar. If you hide the toolbar then you will be increasing the 

amount of information that appears in the Viewer. 
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The style of the Show and Hide buttons differs depending on where the 

Viewer is docked. For example, if the Viewer is docked to the top then the 

Show and Hide buttons appear as Arrows pointing to the left and right.  

    

If the Viewer window is docked to the left then the Show and Hide buttons 

appear as Arrows pointing up and down. 

    

In all cases, the position of the Hide button is always the last button on the 

Viewer Toolbar. 

Pressing LEFT CONTROL+BACKSLASH on your keyboard also hides and 

shows the Viewer Toolbar. 

 

 
  

Magnifying the image in the Viewer 

    

You can change the size of the image in the Viewer by using the 

magnification buttons in the Viewer Toolbar. If you are using a touchscreen 

device, you can also change magnification by doing a 2 finger pinch or 2 

finger stretch. 
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You can also use the following hot keys: 

Magnifier Hot Keys 

Function Desktop Hot 
Keys 

Laptop - 
Universal Set 

Increase magnification LEFT 

CONTROL + 

NUMPAD 

PLUS  

or  

CAPS LOCK + 

MOUSE 

WHEEL UP 

ALT + 

EQUALS 

or 

CAPS LOCK + 

MOUSE 

WHEEL UP 

Reduce magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or 

CAPS LOCK + 

MOUSE 

WHEEL 

DOWN 

ALT + DASH 

or 

CAPS LOCK + 

MOUSE 

WHEEL 

DOWN 

 
  

Viewing other parts of the image 

If you find the image you are looking at is larger than what is appearing in 

the Viewer then you can move the mouse pointer or use SuperNova's Pan 

feature to scroll the image with the keyboard. 

To pan across the screen press RIGHT CONTROL plus an Arrow Key. 

Hold down RIGHT CONTROL to keep panning. Press the same Arrow Key 

repeatedly (keeping RIGHT CONTROL pressed) to speed up the panning. 

Press the opposite Arrow Key to slow down.  

To learn more about panning see "View other parts of the screen". 
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Rotating the image in the Viewer 

 

You can rotate the image in the viewer to present it in a way that is easiest 

for you to read. This avoids the necessity to rotate the text under the 

camera. With each press of this button the image rotates by 90 degrees 

clockwise. 

Pressing LEFT CONTROL + NUM PAD 1 on your keyboard will also rotate 

the image by 90 degrees clockwise each time you press this hot key 

combination. 
  

Changing the colours of the image 

 

If you are finding viewing the image difficult because of the colours and 

contrast, then you can use the Colour Changer button to cycle through a 

number of different colour schemes. 

Pressing LEFT CONTROL + NUM PAD 0 on your keyboard also cycles 

you through the available colour schemes. 

SuperNova saves the Colour Scheme you choose in the "Connect and 

View Settings" dialog box. 
  



 

70 Connect and View 

 

Improving image quality 

SuperNova contains a number of optional image processing features, such 

as an Enhance High Contrast Colours option, that helps boost the contrast 

of images while using one of SuperNova's built in colour schemes. This 

option is particularly useful when viewing pages containing text and 

diagrams. 

SuperNova also contains an Auto Freeze Image option that attempts to 

remove "dancing dots" (also known as impulse noise) from the camera's 

video stream (especially noticeable in poorly lit environments). 

Note: Dancing dots, also known as "salt and pepper" (or impulse) 

noise, is more of a problem when light levels in your environment 

are low and your camera tries to boost the exposure of the image in 

order to capture as much light as possible. However, because the 

camera's image sensor has now been made more sensitive to light, 

its also now more sensitive to random interference too, and so this 

gives rise to increased impulse noise (that resemble dancing dots) in 

successive video frames. 

The individual settings for SuperNova's image processing features can be 

accessed from the Camera tab in Connect & View's Settings dialog box 

(accessible by going to Visual ->Connect & View ->Settings... in 

SuperNova's control panel. 
  

Controlling Auto Focus 

A camera's Auto Focus system, if it has one, is designed to automatically 

adjust the camera lens to give you the sharpest possible image of the 

subject. In some cases the camera may be regularly attempting to refocus 

on what it sees as a changing subject, which may be a distraction. If you 

find the Auto Focus regularly refocusing then you may wish to turn this 

feature off. 

Pressing LEFT CONTROL + NUM PAD 3 on your keyboard toggles Auto 

Focus off and on. 
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Not all cameras include an Auto Focus feature. 
  

Switching between digital and optical zoom 

If your camera is one that supports optical (sometimes also known as 

hardware) zoom your Connect & View viewer window will display an extra 

button that allows you to toggle your camera between digital zoom and 

optical zoom. 

The icon displayed directly below indicates that your camera is currently in 

digital zoom mode. 

Pressing this icon will toggle your camera from digital zoom mode into 

optical zoom mode: 

 

The icon displayed directly below indicates that your camera is currently in 

optical zoom mode. 

Pressing this icon (or LEFT CONTROL + NUMPAD 4) will toggle your 

camera from optical zoom mode into digital zoom mode: 

 
  

Locking the image 
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The Lock Image button lets you freeze the screen on the current image. 

This allows you to explore the image in more detail without the possibility of 

the image changing.  

Although available as a Viewer Toolbar button when using a camera, you 

may find this option more useful when viewing presentations as it will allow 

you to freeze the screen on a particular slide rather than relying on the 

teacher to stop the presentation at that point. When you unlock the image 

the Viewer refreshes the current camera image or shows the current 

presenter's computer screen. 
  

Capture Viewer image 

 

The Capture Image button lets you copy the image in the Viewer to the 

Windows Clipboard. The image SuperNova captures is the full image, 

irrespective of the size of magnification you are using in the Viewer. 

Pressing CAPS LOCK+P also copies the image in the Viewer to the 

Windows Clipboard. 
  

12.1.5  Camera settings 

You can find all the SuperNova Camera Connect and View settings in the 

SuperNova Control Panel. You can find these options through the Visual 

button bar or through the Connect and View menu. For further information 

see the Connect and View Settings dialog box. 
  

12.2  Whiteboard Connect and View 

Whiteboard Connect and View uses virtual network computing (VNC) to let 

you connect to another computer and magnify and track what appears on 

their screen on your computer screen. 
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VNC is a type of software that makes it possible to view another computer 

over a network connection. There are a number of free and low cost VNC 

software programs available. These include tight VNC, Ultra VNC and Real 

VNC. The VNC software must be installed and running on the presenter's 

computer for SuperNova to make a connection. The VNC software does 

not need to be installed on your computer. 

For more information about VNC programs that have been tested and are 

recommended by Dolphin, please visit the Dolphin web site or contact your 

local Dolphin dealer. 
  

12.2.1  Connecting to the presenter's computer 

You can connect to the presenter's computer that is running VNC software 

by creating a whiteboard profile. A whiteboard profile will require you to 

enter specific information, which may only be available from your Network 

Administrator. This information includes the name of the computer and any 

security password set in the VNC software. 

To create a whiteboard profile, do the following in the SuperNova Control 

Panel:  

1. In the "Visual" option, open the "Connect and View" submenu and 

select "Settings". The "Connect and View Settings" dialog box opens. 

2. If this is a new profile you want to create, select the "Whiteboard" page 

and choose the "New" button. The "Whiteboard Settings" dialog box 

opens. 

3. If this is a profile you want to edit, open the "Whiteboard" page, select 

the profile from the "Devices" list and choose the "Settings" button. The 

"Whiteboard Settings" dialog box opens. 

4. In the "Profile" box type a name for this profile. Give the profile a 

meaningful name, for example, the name of the classroom, teacher or 

trainer. 

5. Complete the remaining fields as provided to you by your Network 

Administrator. For further information see the Connect and View 

Settings dialog box section. 
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6. Select the "OK" button. SuperNova saves the settings and goes back to 

the previous dialog box. 

7. Select the "OK" button. SuperNova saves the profile, adds it to the 

Devices list and closes the dialog box. 
  

12.2.2  Viewing the presenter's computer 

To see the presenter's computer screen requires you to select the profile in 

the "Connect and View Settings" dialog box and then to turn on the 

Connect and View feature. 

When you are connected to the presenter's computer, you can use the 

following options to enable, configure and adjust the Viewer. 
  

Switching on the Viewer 

After selecting the device in the "Connect and View Settings" dialog box, 

you can view its output by turning on "Connect and View". You can switch 

on or off "Connect and View" using the "Visual" options in the SuperNova 

control panel or by using a hot key. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Connect and View on off ALT + 

NUMPAD 

ENTER 

LEFT SHIFT + 

CAPS LOCK + 

0 

 

When you turn on "Connect and View" a portion of the screen begins to 

show the image from the camera or whiteboard. This area is called the 

Viewer. You can change the position of the Viewer on the screen and you 

can use the Viewer Toolbar to adjust the size, colour and contrast of the 

image to make it easier to see. 
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Switching between the Viewer and the desktop 

To access the Viewer toolbar and to make adjustments to the image 

requires you to place the focus in the Viewer area. 

You can switch between the Viewer and the desktop by pressing CAPS 

LOCK + MIDDLE MOUSE BUTTON. If you have both an active camera 

and whiteboard connection then pressing CAPS LOCK + MIDDLE MOUSE 

BUTTON cycles you between camera, whiteboard and desktop. 
  

Showing and hiding the Viewer toolbar 

The Viewer Toolbar provides you with controls to modify the image you are 

viewing. The options available on the toolbar differ depending on whether 

you are connecting to a camera or connecting to a whiteboard. 

You can use the Show and Hide buttons to control the appearance of the 

Viewer Toolbar. If you hide the toolbar then you will be increasing the 

amount of information that appears in the Viewer. 

The style of the Show and Hide buttons differs depending on where the 

Viewer is docked. For example, if the Viewer is docked to the top then the 

Show and Hide buttons appear as Arrows pointing to the left and right.  

    

If the Viewer window is docked to the left then the Show and Hide buttons 

appear as Arrows pointing up and down. 
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In all cases, the position of the Hide button is always the last button on the 

Viewer Toolbar. 

Pressing LEFT CONTROL+BACKSLASH on your keyboard also hides and 

shows the Viewer Toolbar. 

 

 
  

Magnifying the image in the Viewer 

    

You can change the size of the image in the Viewer by using the 

magnification buttons in the Viewer Toolbar. If you are using a touchscreen 

device, you can also change magnification by doing a 2 finger pinch or 2 

finger stretch. 

You can also use the following hot keys: 

Magnifier Hot Keys 

Function Desktop Hot 
Keys 

Laptop - 
Universal Set 

Increase magnification LEFT 

CONTROL + 

NUMPAD 

PLUS  

or  

CAPS LOCK + 

MOUSE 

WHEEL UP 

ALT + 

EQUALS 

or 

CAPS LOCK + 

MOUSE 

WHEEL UP 
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Reduce magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or 

CAPS LOCK + 

MOUSE 

WHEEL 

DOWN 

ALT + DASH 

or 

CAPS LOCK + 

MOUSE 

WHEEL 

DOWN 

 
  

Viewing other parts of the image 

If you find the image you are looking at is larger than what is appearing in 

the Viewer then you can move the mouse pointer or use SuperNova's Pan 

feature to scroll the image with the keyboard. 

To pan across the screen press RIGHT CONTROL plus an Arrow Key. 

Hold down RIGHT CONTROL to keep panning. Press the same Arrow Key 

repeatedly (keeping RIGHT CONTROL pressed) to speed up the panning. 

Press the opposite Arrow Key to slow down.  

To learn more about panning see "View other parts of the screen". 

 
  

Changing the colours of the image 

 

If you are finding viewing the image difficult because of the colours and 

contrast, then you can use the Colour Changer button to cycle through a 

number of different colour schemes. 
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Pressing LEFT CONTROL + NUM PAD 0 on your keyboard also cycles 

you through the available colour schemes. 

SuperNova saves the Colour Scheme you choose in the "Connect and 

View Settings" dialog box. 
  

Tracking the presenter's movement 

 

You can control the tracking of the presenter's movement by using the 

Track Presenter button. When you turn on this feature, the image in the 

Viewer will automatically scroll to follow the movement of the presenter's 

mouse pointer around the screen. The tracking of the presenter's mouse 

pointer will temporarily stop if you begin to move your mouse pointer and 

tracking resumes again when you stop moving your mouse pointer. 

You can prevent the Viewer following the presenter's mouse pointer by 

turning this feature off. 
  

Locking the image 

    

The Lock Image button lets you freeze the screen on the current image. 

This allows you to explore the image in more detail without the possibility of 

the image changing.  

Although available as a Viewer Toolbar button when using a camera, you 

may find this option more useful when viewing presentations as it will allow 

you to freeze the screen on a particular slide rather than relying on the 

teacher to stop the presentation at that point. When you unlock the image 
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the Viewer refreshes the current camera image or shows the current 

presenter's computer screen. 
  

Capture Viewer image 

 

The Capture Image button lets you copy the image in the Viewer to the 

Windows Clipboard. The image SuperNova captures is the full image, 

irrespective of the size of magnification you are using in the Viewer. 

Pressing CAPS LOCK+P also copies the image in the Viewer to the 

Windows Clipboard. 
  

12.2.3  Whiteboard settings 

You can find all the SuperNova Whiteboard Connect & View settings in the 

SuperNova Control Panel. You can find these options through the Visual 

button bar or through the Connect & view menu. For further information see 

the Connect & View Settings dialog box. 
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C H A P T E R  1 2  

Touchscreen 

13.1  Touchscreen terminology 

The following table provides a description of touchscreen gestures and 

what the gesture means. 

 

Gesture How to do it 

Tap Tap the screen to 

perform an action, for 

example, tap a button 

to activate the button. 

Some gestures may 

require you to tap the 

screen with 1, 2, 3 or 

more fingers multiple 

times. 

Press and hold Press a finger on the 

screen and continue to 

hold the finger against 

the screen. 

Swipe A flick of a finger 

across the screen. 

Slide A longer slower 

movement of a finger 

across the screen 

usually in a vertical or 

horizontal direction 

from the screen edge. 
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Pinch Press two fingers on 

the screen and move 

them together, as if 

you are pinching them 

together. 

Stretch Press two fingers on 

the screen and move 

them away from each 

other, as if you are 

stretching them apart. 

 
  

13.2  Touchscreen gestures 

The following table provides a list of the touchscreen gestures you can use 

to control SuperNova. 

 

Function Gesture 

Toggle magnification 3 finger double tap 

Increase magnification 2 finger stretch 

Reduce magnification 2 finger pinch 

Pan 1 finger swipe 

Show / hide the SuperNova 

Touch Bar 

3 finger single tap 

 
  

More gestures. 

In addition to the SuperNova touchscreen gestures, here are some more 

touchscreen gestures to help you get around Windows. 
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Function Gesture 

Open the Charms (Search, 

Share, Start, Devices, Settings). 

Slide in from over the 

right edge with 1 finger 

Switch apps Swipe in from over the 

left edge with 1 finger. 

Open the App Menu. The App 

Menu shows commands like 

Save, Edit and Delete. 

Slide in from over the 

bottom edge with 1 

finger. 

Close the open app Slide in from over the 

top edge with 1 finger 

and continue the 

motion, dragging the 

app down to the 

bottom of the screen. 

Open the context menu (this is 

the same as performing a right 

click on a selected item) 

1 finger double tap, 

hold and release. 

Drag and drop objects around 

the screen, for example, when 

re-arranging the Start Screen or 

desktop. 

1 finger double tap and 

hold, then slide to 

move the object. Lift 

finger to release. 

 
  

13.3  SuperNova Touch Bar 

The SuperNova Touch Bar is a touchscreen toolbar that appears at the 

bottom of the screen when you do a 3 finger  single tap. The Touch Bar 

gives you access to the most common SuperNova actions including turning 

magnification on and off, changing magnification size and turning the 

SuperNova Colour Scheme on and off. 
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13.4  Typing on a touchscreen 

SuperNova automatically shows an onscreen keyboard when you need to 

type and you do not have a keyboard connected to the device. The 

onscreen keyboard appears at the bottom of the screen and uses large 

print high contrast keys. 

You can also make the keyboard appear at any time by tapping the 

Keyboard button in the SuperNova Touch Bar or by tapping the Keyboard 

button in the Windows Notification area. To hide the keyboard, tap the large 

"X" button in the bottom right corner of the onscreen keyboard. 

You can adjust the appearance of the onscreen keyboard in the 

Touchscreen Settings dialog box. 
  

13.5  Adjust touch sensitivity 

You can adjust how sensitive SuperNova is to your taps and swipes on the 

touchscreen.  

For example, If you find that SuperNova is interpreting a double tap gesture 

as two single tap gestures then you may need to increase the double-tap 

timeout”. In the same way, if you find that when attempting to drag and 

drop a desktop icon the icon is not being picked up, then you may need to 

increase the double-tap timeout or the pass-through timeout”. 

You make the changes to SuperNova's touchscreen settings in the 

Touchscreen dialog box. 
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Hot key conflicts 

Sometimes you can find SuperNova hot keys conflict with an application's 

hot keys. You can resolve this issue in a number of different ways. 
  

14.1  Turn off SuperNova hot keys 

You can resolve a hot key conflict between SuperNova and your 

application by turning off SuperNova's hot keys. This disables all hot keys 

except for the hot key to turn on SuperNova's hot keys again. 

Action Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Turn off or on hot keys LEFT 

CONTROL + 8 

SHIFT + 

CAPS LOCK + 

3 

 
  

14.2  Tell SuperNova to ignore the next key press 

You can resolve a hot key conflict between SuperNova and your 

application by telling SuperNova to ignore the next key press. Once you 

have released the keys, SuperNova automatically turns on its hot keys 

again. 

Action Hot Keys 
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Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Pass the next key press 

through to your application 

LEFT 

CONTROL + 7 

CAPS LOCK + 

3 

 
  

14.3  Reassign a SuperNova hot key 

You can add, delete or reassign any SuperNova hot key. You can do this to 

resolve hot key conflicts between SuperNova and your application or to 

change a hot key command to a key combination you find easier to use. 

To do this: 

1. Press LEFT CONTROL + SPACEBAR. 

The SuperNova control panel opens. 

2. Press ALT + G. 

The "General" menu opens. 

3. DOWN ARROW to "Keyboard and Hot Keys" and press ENTER. 

A submenu opens. 

4. DOWN ARROW to "Hot Keys" and press ENTER. 

The "Hot Keys" dialog box opens. 

5. TAB through, using the "Hot Key Command Set" list and "Command" 

list to select the assigned hot key you want to change. 

6. Use the "Add key" button, "Replace key" button or "Remove key" button 

to change the hot key. 

7. TAB to the "OK" button and press SPACEBAR. 

SuperNova confirms the changes and closes the dialog box. 
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Tip: If you find it difficult to locate your hot key from the categories 

and commands available then use the SuperNova Key Describer to 

help. 
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Hot Keys 

15.1  Actions 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Control Panel Pop Up Menu CAPS LOCK + 

SPACEBAR 

CAPS LOCK + 

SPACEBAR 

Doc Reader SHIFT + ALT + 

D 

CAPS LOCK + 

F11 

SuperNova Help CAPS + F1 

or RIGHT 

CONTROL + 

RIGHT SHIFT + 

FORWARD 

SLASH 

CAPS + F1 

Hot Keys on / off LEFT 

CONTROL + 8 

SHIFT + CAPS 

LOCK + 3 

Open Control Panel LEFT 

CONTROL + 

SPACEBAR 

LEFT 

CONTROL + 

SPACEBAR 

Pass next key to application LEFT 

CONTROL + 7 

CAPS LOCK + 

3 

Quit CAPS LOCK + 

F4 

CAPS LOCK + 

F4 

Row / Column Mode Toggle LEFT 

CONTROL + 9 

No Assignment 

Screen Refresh LEFT 

CONTROL + 

SEMI COLON 

CAPS LOCK + 

ESCAPE 
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15.2  Magnifier 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal 

Colour Scheme on off LEFT 

CONTROL + 

NUMPAD 0 

SHIFT + ALT + 

C 

Create Hooked Area LEFT 

CONTROL + 

NUMPAD 5 

LEFT SHIFT + 

LEFT 

CONTROL + 

ALT + H 

Foci Highlights on off LEFT 

CONTROL + 

LEFT SHIFT + 

BACK SLASH 

LEFT SHIFT + 

LEFT ALT + O 

Hooked areas on off LEFT 

CONTROL + 

NUMPAD 3 

No Assignment 

Jump Down LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 2 

LEFT ALT + 

PAGE DOWN 

Jump Left LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 4 

LEFT ALT + 

HOME 

Jump Right LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 6 

LEFT ALT + 

END 

Jump Up LEFT 

CONTROL + 

CAPS LOCK + 

NUMPAD 8 

LEFT ALT + 

PAGE UP 
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Magnification Decrease LEFT 

CONTROL + 

NUMPAD 

MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

LEFT ALT + 

MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

Magnification Increase LEFT 

CONTROL + 

NUMPAD 

PLUS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 

LEFT ALT + 

EQUALS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 

Magnification X Decrease RIGHT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Magnification X Increase LEFT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Magnification Y Decrease RIGHT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Magnification Y Increase LEFT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Magnifier on off LEFT 

CONTROL + 

NUMPAD 

ENTER 

ALT + 0 

Modify Hooked Areas LEFT 

CONTROL + 

NUMPAD 6 

LEFT SHIFT + 

ALT + H 
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Modify Primary Area LEFT 

CONTROL + 

NUMPAD 4 

LEFT SHIFT + 

ALT + A 

Move Down RIGHT 

CONTROL + 

RIGHT SHIFT + 

DOWN 

ARROW 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

DOWN 

ARROW 

Move Left RIGHT 

CONTROL + 

RIGHT SHIFT + 

LEFT ARROW 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

LEFT ARROW 

Move Right RIGHT 

CONTROL + 

RIGHT SHIFT + 

RIGHT 

ARROW 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

RIGHT 

ARROW 

Move to bottom left of screen RIGHT 

CONTROL + 

NUMPAD 1 

No Assignment 

Move to bottom of screen RIGHT 

CONTROL + 

NUMPAD 2 

No Assignment 

Move to bottom right of 

screen 

RIGHT 

CONTROL + 

NUMPAD 3 

No Assignment 

Move to left edge of screen RIGHT 

CONTROL + 

NUMPAD 4 

No Assignment 

Move to middle of screen RIGHT 

CONTROL + 

NUMPAD 5 

No Assignment 

Move to right edge of screen RIGHT 

CONTROL + 

NUMPAD 6 

No Assignment 

Move to top left of screen RIGHT 

CONTROL + 

NUMPAD 7 

No Assignment 
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Move to top of screen RIGHT 

CONTROL + 

NUMPAD 8 

No Assignment 

Move to top right of screen RIGHT 

CONTROL + 

NUMPAD 9 

No Assignment 

Move Up RIGHT 

CONTROL + 

RIGHT SHIFT +  

UP ARROW 

RIGHT 

CONTROL + 

RIGHT SHIFT + 

UP ARROW 

Orientation Cycle LEFT 

CONTROL + 

NUMPAD 1 

No Assignment 

Overview mode on off LEFT 

CONTROL + 

BACK SLASH 

No Assignment 

Pan Down RIGHT 

CONTROL + 

DOWN 

ARROW 

RIGHT 

CONTROL + 

DOWN 

ARROW 

Pan Left RIGHT 

CONTROL + 

LEFT ARROW 

RIGHT 

CONTROL + 

LEFT ARROW 

Pan Right RIGHT 

CONTROL + 

RIGHT 

ARROW 

RIGHT 

CONTROL + 

RIGHT 

ARROW 

Pan Up RIGHT 

CONTROL + 

UP ARROW 

RIGHT 

CONTROL + 

UP ARROW 

Primary Magnifier Type Cycle LEFT 

CONTROL + 

NUMPAD 7 

LEFT SHIFT + 

ALT + M 

Restore Position RIGHT 

CONTROL + 

NUMPAD 

PERIOD 

No Assignment 
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Save Position RIGHT 

CONTROL + 

NUMPAD 0 

No Assignment 

Switch monitors CAPS LOCK + 

MIDDLE 

MOUSE 

BUTTON 

CAPS LOCK + 

MIDDLE 

MOUSE 

BUTTON 

Cycle text smoothing (True 

Font/Standard/Off) 

LEFT 

CONTROL + 

NUMPAD 8 

No Assignment 

Bold Fonts on off RIGHT 

CONTROL + 

NUMPAD 8 

No Assignment 

Sharpening on off RIGHT 

CONTROL + 

RIGHT SHIFT + 

NUMPAD 8 

No Assignment 

 
  

15.3  Magnifier Window Adjustment 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Alter hook with mouse LEFT MOUSE 

BUTTON 

LEFT MOUSE 

BUTTON 

Area Down DOWN 

ARROW 

DOWN 

ARROW 

Area Left LEFT ARROW LEFT ARROW 

Area Right RIGHT 

ARROW 

RIGHT 

ARROW 

Area Up UP ARROW UP ARROW 

Cancel Get Hook Area ESCAPE ESCAPE 

Contents Down LEFT SHIFT + 

DOWN 

ARROW 

LEFT SHIFT + 

DOWN 

ARROW 
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Contents Left LEFT SHIFT + 

LEFT ARROW 

LEFT SHIFT + 

LEFT ARROW 

Contents Right LEFT SHIFT + 

RIGHT 

ARROW 

LEFT SHIFT + 

RIGHT 

ARROW 

Contents Up LEFT SHIFT + 

UP ARROW 

LEFT SHIFT + 

UP ARROW 

Cycle Orientation LEFT 

CONTROL + 

NUMPAD 1 

No Assignment 

Decrease Magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

ALT + MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

Decrement X Magnification RIGHT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Decrement Y Magnification RIGHT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Delete Hooked Area DELETE DELETE 

Exit Modification Mode ESCAPE ESCAPE 

Increase Magnification LEFT 

CONTROL + 

NUMPAD 

PLUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

ALT + EQUALS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 

Increment X Magnification LEFT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 
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Increment Y Magnification LEFT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Make narrower LEFT 

CONTROL + 

LEFT ARROW 

LEFT 

CONTROL + 

CLEFT 

ARROW 

Make shorter LEFT 

CONTROL + 

UP ARROW 

LEFT 

CONTROL + 

UP ARROW 

Make taller LEFT 

CONTROL + 

DOWN 

ARROW 

LEFT 

CONTROL + 

DOWN 

ARROW 

Make wider LEFT 

CONTROL + 

RIGHT 

ARROW 

LEFT 

CONTROL + 

RIGHT 

ARROW 

Move area with mouse Z Z 

Move contents of area with 

mouse 

C C 

OK Get Hook Area ENTER 

or RIGHT 

MOUSE 

BUTTON 

ENTER 

or RIGHT 

MOUSE 

BUTTON 

Resize area with mouse X X 

Text Smoothing LEFT 

CONTROL + 

NUMPAD 8 

No Assignment 

Tracking on off LEFT SHIFT + 

NUMPAD 8 

No Assignment 
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15.4  Line View 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Decrease magnification LEFT 

CONTROL + 

NUMPAD 

MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

ALT + MINUS 

or CAPS LOCK 

+ MOUSE 

WHEEL DOWN 

Decrement X magnification RIGHT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Decrement Y magnification RIGHT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Exit Line View ESCAPE ESCAPE 

Exit Line View and click at 

character or route Dolphin 

Cursor to character 

NUMPAD 

ENTER 

ENTER 

or LEFT 

MOUSE 

BUTTON 

Flip forward ENTER ENTER 

Go to the first line HOME HOME 

Go to the focus NUMPAD 0 F5 

Go to the last line END END 

Increase magnification LEFT 

CONTROL + 

NUMPAD 

PLUS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 

ALT + EQUALS 

or CAPS LOCK 

+ MOUSE 

WHEEL UP 
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Increment X magnification LEFT 

CONTROL + 

NUMPAD 

SLASH 

No Assignment 

Increment Y magnification LEFT 

CONTROL + 

NUMPAD 

STAR 

No Assignment 

Line View document LEFT 

CONTROL + 

NUMPAD 

PERIOD 

No Assignment 

Line View document area and 

go to focus 

LEFT 

CONTROL + 

LEFT SHIFT + 

NUMPAD 2 

No Assignment 

Line View document from 

cursor 

LEFT 

CONTROL + 

NUMPAD 2 

LEFT SHIFT + 

ALT + L 

Line View whole window LEFT 

CONTROL + 

NUMPAD 9 

LEFT SHIFT + 

ALT + V 

Move backwards LEFT ARROW LEFT ARROW 

Move forward RIGHT 

ARROW 

RIGHT 

ARROW 

Next line PAGE DOWN PAGE DOWN 

Previous line PAGE UP PAGE UP 

Scroll faster UP ARROW UP ARROW 

Scroll slower DOWN 

ARROW 

DOWN 

ARROW 

Start or stop SPACEBAR SPACEBAR 

Text smoothing LEFT 

CONTROL + 

NUMPAD 8 

No Assignment 
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15.5  Item Finder 
Function Desktop - 

Default 
NumPad Set 

Laptop - 
Universal Set 

Item Finder (multi tab dialog 

box) 

CAPS LOCK + 

TAB 

CAPS LOCK + 

TAB 

Links CAPS LOCK + 

1 

CAPS LOCK + 

F7 

Headings CAPS LOCK + 

2 

CAPS LOCK + 

F6 

Frames or Objects CAPS LOCK + 

3 

CAPS LOCK + 

F9 

Tables CAPS LOCK + 

5 

No Assignment 

Controls CAPS LOCK + 

6 

CAPS LOCK + 

F5 

Revisions or Comments CAPS LOCK + 

7 

LEFT SHIFT + 

CAPS LOCK + 

R 

Errors CAPS LOCK + 

8 

No Assignment 

 
  

15.6  Quick Navigation Keys for Microsoft Word 

SuperNova coding includes the following list of hot keys for supported 

versions of Microsoft Word. You cannot remove or reassign these keyboard 

commands. 
  

15.6.1  Quick Navigation Keys 

To move to the previous element use Shift + Caps Lock + Key 

Move to Hot key 

Bookmark CAPS LOCK + A 

Button CAPS LOCK + B 
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Comment CAPS LOCK + C 

Different paragraph style CAPS LOCK + D 

Edit form field CAPS LOCK + E 

Footnote or Endnote CAPS LOCK + F 

Graphic CAPS LOCK + G 

Heading style CAPS LOCK + H 

List item CAPS LOCK + I 

Link CAPS LOCK + K 

List CAPS LOCK + L 

Text box CAPS LOCK + Y 

Normal style paragraph CAPS LOCK + N 

Object (including graphics) CAPS LOCK + O 

Paragraph CAPS LOCK + P 

Revision CAPS LOCK + R 

Table CAPS LOCK + T 

Check box CAPS LOCK + X 

Section break CAPS LOCK + Z 

Note that you may find various Quick Navigation Keys failing when working 

in a protected document. 
  

ZoomText to SuperNova product terminology 
guide 

The following table provides a helpful terminology conversion guide for 

ZoomText users transitioning to SuperNova. 

 

ZoomText term SuperNova equivalent 

AppReader Read From Here 

Camera Connect and View (page 55) 

Colour Enhancements Colour Schemes (see "Make 

the screen easier to see" 

page 29) 
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Command Keys Hot Keys 

Cursor Enhancements Highlighting Options ->Cursor 

DocReader Doc Reader (page 37) 

Dual Monitor Multiple Monitor (see "Visual 

Multiple Monitors dialog box" 

page 103) 

Dye Tint (page 94) 

Finder Item Finder (page 86) 

Focus Enhancements Highlighting Options ->Focus 

(see "Make the focus easier 

to see" page 30) 

Font Enhancements Font Smoothing (page 107) 

Freeze Window Hooked Area (see "Create 

static magnified windows to 

display information" page 24) 

Mouse Echo Announce Text Under Mouse 

Pointer Enhancements Highlighting Options ->Mouse 

Pointer Scheme Mouse Pointers (see "Make 

the pointer easier to see" 

page 30) 

Text Finder Find with Dolphin Cursor 

Text Processing Text Style Announcements 

Text Reading Commands Speak Keys 

Typing Echo Character Echo 

View mode Overview mode (see "Get an 

overview of the magnified 

window position" page 23) 

Window Type Magnifier View (see "Change 

Magnifier view" page 18) 

Web Finder Item Finder (page 86) 

Zoom Level Magnification Size (see 

"Change magnification size" 

page 17) 
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C H A P T E R  1 5  

Reference 

17.1  New Situation Settings dialog box 

Menu: File > New > Situation Settings 

You can create or choose an existing Situation by using options in the 

"New Situation Settings" dialog box. 

Options: 

 Create New Situation radio button. 

You can create a new Situation Setting by selecting this radio button 

and then choosing the "OK" button. This will move you to the next 

step in the creation process. To review all steps in this process please 

refer to the "Create Situation Settings" topic. 

 Use an existing Situation radio button. 

You can change to another Situation by selecting this option and then 

selecting from the available list. Note the Situation list will show only 

those Situation Settings available in the current Application Settings 

file. 
  

17.2  New Application Settings dialog box 

Menu: File > New > Application Settings 

You can create or choose an existing Application Settings file by using 

options in the Application Settings dialog box. 

Options: 

 Create a new settings file radio button. 

You can create a new Application Settings file by selecting this option 

and then choosing the "OK" button. After selecting the "OK" button, 
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you will go to the next step in the creation process. To review all steps 

in this process please refer to the "Create Application Settings" topic. 

 Use an existing settings file radio button. 

You can change to a different settings file by selecting this option and 

then by selecting a file from the available list. You confirm your 

selection by choosing the "OK" button. The settings will apply 

immediately unless you select the option "Use Default Settings in the 

control panel". If you do select this option then your new settings will 

apply when you go back to your application. 
  

17.3  New Map dialog box 

Menu: File > New > Map 

You can create or choose an existing Map file by using options in the 

"Select New Map" dialog box. 

Options: 

 Create a new Map file radio button. 

You can create a new Map file by selecting this radio button and then 

choosing the "OK" button. This will move you to the next step in the 

creation process. To review all steps in this process please refer to 

the "Mapping Guide". This is available through the SuperNova "Help" 

menu. 

 Use an existing Map file radio button. 

You can change to an alternative Map file by selecting this option and 

then selecting a file from the available list. To learn more about the 

reasons why you might change a Map file please refer to the "Change 

Map file" topic. 
  

17.4  New Script menu item 

Menu: File > New > Script 

You can create a new Script file for the current application by selecting this 

menu item. The new Script file will open in the Dolphin Script Editor. The 
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Dolphin Script Editor includes a "Help" menu with options linking to the 

Scripting Guide. 

Note: If a Script file exists for the current application then this menu 

item will be disabled. To view and edit an existing Script file, go to 

the "File" menu, "Edit" sub-menu and select "Script". 

  

17.5  Edit Situation Settings dialog box 

Menu: File > Edit > Situation Settings 

You can delete or change the properties of your Situation Settings by using 

options in the "Situation Management" dialog box. Note that you must be 

using the Application Settings file that has the Situation Settings to be able 

to edit the Situations in that file. 

 Situation list. 

You can choose the Situation you want to edit or delete from this list. 

 Edit Rules button. 

You can edit the rules of a Situation by selecting this  button. This will 

open the "Define Situation Rules" dialog box. In this dialog box you 

can change the name of the Situation, change the title and class 

details of the Situation rule and add and remove Situation rules. 

 Delete button. 

You can delete the current Situation from your Application Settings file 

by selecting this button. After selecting the button you will receive a 

warning message asking you to confirm that you want to proceed. To 

proceed select the "Yes" button or to cancel select the "No" button. 
  

17.6  Edit Application Settings dialog box 

Menu: File > Edit > Application Settings 

You can delete or change the properties of your Application Settings file by 

using options in the "Settings File Management" dialog box. 

 Application Settings file list. 

You can choose the Application Settings file you want to edit or delete 
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from this list. Note that you cannot delete the "Default Application" 

settings file because this is a SuperNova system file. 

 Properties button. 

You can edit the properties of an Application Settings file by selecting 

this  button. This will open the "Settings File Properties" dialog box. 

In this dialog box you can change the name and version number of 

the settings file and add and remove any the applications associated 

with the file. 

 Delete this settings file button. 

You can delete the current Application Settings file by selecting this 

button. After selecting the button you will receive a warning message 

asking you to confirm that you want to proceed. To proceed select the 

"Yes" button or to cancel select the "No" button. 
  

17.7  Edit Map dialog box 

Menu: File > Edit > Map 

You can edit the properties and rules of a Map file by selecting this menu 

item. To learn more about Map files please refer to the Mapping Guide 

available from the "Help" menu of the SuperNova control panel. 

This dialog box also contains Script options. You can create, reload, edit 

and delete Script files and Extension Script files. To learn more about 

Script files please refer to the Scripting Guide. You can open the Scripting 

Guide from the SuperNova control panel "Help" menu. 
  

17.8  Edit Script menu item 

Menu: File > Edit > Script 

You can edit the Script file for the current application by selecting this menu 

item. The Script file will open in the Dolphin Script Editor. The Dolphin 

Script Editor includes a "Help" menu with options linking to the Scripting 

Guide. 
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Note: If no Script file exists for the current application then this menu 

item will be disabled. To create a new Script file, go to the "File" 

menu, "New" sub-menu and select "Script". 

  

17.9  Visual Configure Custom Colour Scheme dialog box 

Menu: Visual > Colour Schemes > Configure. 

You can create your own colour scheme by using options in the "Configure 

Custom Colour Scheme" dialog box. 

Note: To open this dialog box you must choose "Custom" as your 

Colour Scheme and then choose "Configure" from the list of Colour 

Schemes. 

You can create a custom scheme in this dialog box using one of the 

following options: 

 Classic 

 Tint 

 Dual Tint 

 Treble Tint 

 Quad Tint 

 Colour Replacement 

The controls available in this dialog box change depending on the custom 

setting you have chosen. 
  

17.9.1  Classic custom colour scheme options. 

 Invert brightness check box. 

This option inverts the brightness of the screen, turning a typically 
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dark on light screen to a light on dark screen. This option does not 

affect the amount of colour on the screen. 

 Contrast slider. 

The "Contrast" slider controls colour definition, making light colours 

lighter and dark colours darker. This changes the screen in a similar 

way to the Contrast button you find on a television. 

 Brightness slider. 

The "Brightness" slider controls how bright the colours appear on the 

screen, making light colours more luminous and dark colours darker. 

This changes the screen in a similar way to the Brightness button you 

find on a television. 

 Luminance Split slider. 

The luminance Split is the position in the colour spectrum where light 

and dark colours divide. Moving the slider to the left means more of 

the colours in the spectrum are classified as being in the lighter 

spectrum. This influences the contrast and brightness values. 

 Colour Adjust slider. 

The "colour adjust" slider allows you to make general changes to 

screen colours with the exception of white and black. You can use the 

colour palette to view the changes that occur as you move the slider. 

A slider position of 0% means screen colours are unchanged. 

 Colour slider. 

The "Colour" slider allows you to control how much colour is on the 

screen. Changing this value means colours either become paler or 

more intense. You can use the colour palette to view the changes that 

occur as you move the slider. A slider position of 50% means screen 

colours are unchanged. 

 Preview these colour settings when in this dialog box check box. 

Select this check box to see your changes occur as you make them. 
  

17.9.2  Tint, Dual Tint, Treble Tint and Quad Tint custom colour 
options: 

 Invert brightness check box. 

This option inverts the brightness of the screen, turning a typically 
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dark on light screen to a light on dark screen. This option does not 

affect the amount of colours on the screen. 

 Contrast slider. 

The "Contrast" slider controls colour definition, making light colours 

lighter and dark colours darker. This changes the screen in a similar 

way to the Contrast button you find on a television. 

 Brightness slider. 

The "Brightness" slider controls how bright the colours appear on the 

screen, making light colours more luminous and dark colours darker. 

This changes the screen in a similar way to the Brightness button you 

find on a television. 

 Luminance Split slider. 

The Luminance Split is the position in the colour spectrum where light 

and dark colours divide. Moving the slider to the left means more of 

the colours in the spectrum are classified as being in the lighter 

spectrum. This influences the contrast and brightness values. When 

using Treble Tint and Quad Tint, additional contrast boundary sliders 

are available to define the boundary for the colours in the middle 

colour ranges. 

 Level slider. 

The "Level" slider allows you to control how intense the tint colour is 

applied to the screen. A value of 100%, where the slider is positioned 

to the right, means the tint colours completely replace the current 

screen colours. A value of 25% means the tint colours will be blended 

with the original screen colours at a ratio of 25:75, which creates a 

screen with more shades. 

 Tint colour list boxes. 

You will be able to choose from one to four different colours 

depending on whether you have chosen "Tint", "Dual Tint", "Treble 

Tint" or "Quad Tint". The colours you choose become the primary 

colours for the colour spectrum relative to the Luminance Split. 

 Preview these colour settings when in this dialog box check box. 

Select this check box to see your changes occur as you make them. 
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17.9.3  Colour Replacement custom colour scheme options: 

 Invert brightness check box. 

This option inverts the brightness of the screen, turning a typically 

dark on light screen to a light on dark screen. This option does not 

affect the amount of colours on the screen. 

 Contrast slider. 

The "Contrast" slider controls colour definition, making light colours 

lighter and dark colours darker. This changes the screen in a similar 

way to the Contrast button you find on a television. 

 Brightness slider. 

The "Brightness" slider controls how bright the colours appear on the 

screen, making light colours more luminous and dark colours darker. 

This changes the screen in a similar way to the Brightness button you 

find on a television. 

 Luminance Split slider. 

The Luminance Split is the position in the colour spectrum where light 

and dark colours divide. Moving the slider to the left means more of 

the colours in the spectrum are classified as being in the lighter 

spectrum. This influences the contrast and brightness values. 

 From and To list boxes. 

The "From" and "To" list boxes allow you to replace one colour with 

another colour. Use the list boxes to make one or multiple colour 

replacements. 

 Preview these colour settings when in this dialog box check box. 

Select this check box to see your changes occur as you make them. 
  

17.10  Visual Highlighting Options dialog box 

Menu: Visual > Highlighting > Settings 

You can make different types of focus easier to see by adding a highlight 

indicator. You can choose the style, colour and behaviour of the highlight in 

the "Highlighting Options" dialog box. 
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Mouse tab. 

 Highlight the mouse check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note 

that selecting "On hot key" means you control the highlight using the 

Foci Highlights hot key and selecting "Dynamic tracking" means the 

mouse highlight stays visible until you press a key on the keyboard. 

 Effects group. 

You can choose from different colour options. Depending on the 

option you choose you can also control the colour(s) and/or the 

transparency. 
  

Cursor tab. 

 Highlight the Cursor check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note 

that selecting "On hot key" means you control the highlight using the 

Foci Highlights hot key and selecting "Dynamic tracking" means the 

Cursor highlight stays visible until SuperNova is tracking a different 

type of focus, for example, the mouse. 

 Effects group. 

You can choose from different colour options. Depending on the 

option you choose you can also control the colour(s) and/or the 

transparency. 
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Line tab. 

 Highlight the Line check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note 

that selecting "On hot key" means you control the highlight using the 

Foci Highlights hot key and selecting "Dynamic tracking" means the 

Line highlight stays visible until SuperNova is tracking a different type 

of focus, for example, the mouse. 

 Effects group. 

You can choose from different colour options. Depending on the 

option you choose you can also control the colour(s) and/or the 

transparency. 
  

Focus tab. 

The term "Focus" refers to the focus used in dialog boxes and menus. 

 Highlight the Focus check box. 

Select this check box to turn on the highlighting of this focus. Deselect 

this check box to turn off the highlighting of this focus. 

 Display group. 

Use the "Shape" settings to change the shape and size of the 

highlighting. 

Use the "Show" list box to control when the highlight is visible. Note 

that selecting "On hot key" means you control the highlight using the 

Foci Highlights hot key and selecting "Dynamic tracking" means the 

Focus highlight stays visible until SuperNova is tracking a different 

type of focus, for example, the mouse. 

 Effects group. 

You can choose from different colour options. Depending on the 
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option you choose you can also control the colour(s) and/or the 

transparency. 
  

17.11  Visual Mouse Pointers dialog box 

Menu: Visual > Mouse Pointers 

Available with SuperNova are mouse pointers that are larger and easier to 

see than the usual Windows mouse pointers. The pointers are available in 

a range of different colours and sizes. 

Options: 

 Scheme list. 

You can choose an existing Mouse Pointer scheme from this list. If no 

existing scheme is suitable, use the other options to create a new 

scheme or modify an existing scheme. 

 Type list and Pointer Image list. 

The "Type" list shows the different pointers in Windows and the 

"Pointer Image" list shows the different images you can apply to the 

selected pointer type. To change a pointer, select the type of pointer 

and then choose a pointer from the images provided. 

 New button. 

Pressing the "New" button will open the "Create New Scheme" dialog 

box. In this dialog box, you enter a new name for the scheme. The 

new scheme name appears in the "Scheme" list. 

 Restore to defaults button. 

If you have modified a default SuperNova scheme, then selecting this 

button will return the scheme back to the SuperNova default pointers 

for the scheme. 

 Delete button. 

If you have created a new scheme, then pressing this button will open 

a message window asking you to confirm that the scheme is to be 

deleted. Choose "Yes" to delete the scheme or "No" to cancel. 
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 Custom pointer size group. 

The options in this group allow you to adjust the size of the mouse 

pointers in the current scheme, relative to their default size. 

Use custom pointer size check box. 

If you select this check box the value in the "Size" list will apply to all 

pointers in the current scheme. 

Size list. 

The "Size" list contains a range of values you can apply to the 

pointers in your current scheme. You can choose a fixed size, for 

example 8, which will increase the pointers to 8 times their original 

size. When a fixed value is chosen, the pointers will remain at the 

same size regardless of what magnifier size you have set. 

Alternatively, you can choose a value relative to your magnification 

level, for example 150%. With a relative value, the pointer size will 

adjust as you increase or decrease your magnification size. At higher 

magnification levels you may find the fixed pointer size occupies too 

much of the screen, so you may benefit from choosing a relative 

pointer size smaller than the original size. 

Use custom pointer in magnified areas only check box. 

If you select this check box then the custom pointer size is only 

visible in magnified areas. It is not visible when you turn off the 

Magnifier or view the unmagnified screen in Views such as Split 

Screen. 
  

17.12  Visual Doc Reader Settings dialog box 

Menu: Visual > Doc Reader Settings 

The options available in the "Doc Reader Settings" dialog box control the 

Doc Reader reading environment. You can open this dialog box by 

selecting the item in the "Visual" menu or by selecting the "Settings" button 

from the Doc Reader toolbar. 

Options: 
  

 Font settings. 

In the Doc Reader you can define the font that is used to display the 
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text within the document window.  You can also state the font size to 

use. 

 Colour settings. 

You can define the colours to use in the document window. There are 

three categories to which you can apply a foreground and background 

colour too. 

Document colours sets the background and foreground colours used 

in the document window.  However, if "Use document colours" is 

selected then this setting will not be applied. 

Word highlight colours sets the background and foreground colours 

used by the Doc Reader for the current focus.  This shows the 

currently selected word as the Doc Reader reads through the 

document.  However, if "Invert word" is selected then this setting will 

not be applied.  Instead the highlight will be inverted based on the 

custom colour settings. 

Unit highlight colours sets the background and foreground colours 

for your specified unit of movement.  This is what is highlighted as 

you cursor down through a document. 

 Fetch whole document check box. 

With the "Fetch whole document" check box selected you will load the 

complete document into the Doc Reader.  Depending on the size of 

the document, this may take a few seconds.  This option is only 

supported in DOM enabled applications such as Microsoft Word, 

Adobe Acrobat Reader, Internet Explorer, NotePad, WordPad, etc. 

It is also possible to specify the number of lines you want to fetch by 

unselecting the "Fetch whole document" check box and then 

specifying the number of lines from the available spin control.  This 

will allow you to load a section of a document faster. 

If you are working in an application that does not include DOM 

support then the Doc Reader will load the content from the current 

screen.   

 Invert word check box. 

With the selection of the "Invert word" check box the focus highlighting 

will be an inverted highlight based on the document colours specified 

or based on the actual document's colours depending on what is 

currently enabled. 
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 Use document colours check box. 

Selecting this check box will mean that the Doc Reader will use the 

colours specified in the document instead of its own custom colours.  

 Use document styles check box. 

Selecting this option will mean styles used in the document will 

appear in the Doc Reader. 

 Wrap line to. list. 

The "Wrap line to" option can be used to insert a line break on a line if 

it exceeds a particular length. This can be useful if lines are scrolling 

outside the current window. 

To disable this feature set the "Wrap line to" value to 0. 
  

17.13  Visual Connect and View Settings dialog box 

Menu: Visual > Connect and View > Settings 

The "Connect and View Settings" dialog box contains options you can use 

to change how SuperNova works with a camera and a whiteboard. 
  

Cameras tab. 

 Devices list and controls 

Use this list to select a camera to use with SuperNova. Set the value 

to "Off" if you want to prevent the selection of a camera when you 

switch between devices. Use the "Settings" button to optimise the 

camera performance. These options will differ between camera 

models. The following options are available: 

Resolution list 

This lists available resolutions for your connected camera. Increasing 

the Resolution should improve the picture quality shown in the 

viewer. 

Frame Rate list 

This is listed as frames per second (FPS). The higher FPS means 

frequently changing images appear smoother whereas lower FPS 

can decrease the amount of camera wobble detected, which may 

bring a better document reading experience. 
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Anti Flicker list 

This lists 50Hz which is usually selected for Europe and the UK and 

60Hz usually selected for America and Japan. Selecting the correct 

Hz will eliminate flicker caused by florescent lighting that can interfere 

with a camera image.  

Automatic Focusing check box. 

If you find the Auto Focus regularly refocusing then you may wish to 

turn this feature off. Not all cameras include an Auto Focus feature. 

SuperNova will only make the Auto Focus check box available if the 

camera supports this feature. 

 Colour Scheme list 

Use this option to apply a default colour scheme to the camera viewer. 

Additional options are also available in the camera viewer to control 

the Colour Scheme setting. 

 Use Camera Hardware Zoom check box 

Use this option to enable hardware optical zooming for cameras that 

support it (rather than digital zooming). This results in an improved 

magnified image. 

 Use Camera Colour Changer check box 

Use this option to enable hardware colour changing options for 

cameras that support it (rather than software colour changing). 

 Enhance High Contrast Colours check box 

Use this option to boost the contrast of viewed images while using 

one of SuperNova's built in colour schemes. (This option is particularly 

useful when viewing pages containing text and diagrams). 

 Auto Freeze Image check box 

Use this option to remove "dancing dots" (also known as "salt and 

pepper" or "impulse" noise) from the camera's video stream 

(especially useful in poorly lit environments).  
  

Whiteboards tab. 

 Devices list and controls. 

Use this list to create, edit or delete a device profile. Set the value to 

"Off" if you want to prevent switching to a whiteboard device. Use the 

"New" button to create a new profile. Use the "Settings" button to edit 
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a profile. The following additional options are available when you 

create or edit a profile: 

Profile box. 

Use this box to give the device a meaningful name. You may want to 

name the device after the classroom, teacher or trainer to make it 

easy to select it in the future. Note that the remaining options in this 

dialog box may require information from a Network Administrator. 

Machine Name box. 

Use this box to enter in the name of the host computer as it appears 

on the network. Alternatively, you can also enter in the host 

computer's IP address, however, this is not recommended because 

of the dynamic assignment of IP addresses under most network 

configurations. 

Port box. 

By default, Virtual Network Computing (VNC) uses port 5900. You 

should only change this setting if directed to do so by your Network 

Administrator. 

Password box. 

Use this box to enter in the password that allows you to connect to 

the host computer. The assignment of a password is optional and is 

set in the VNC software. Your Network Administrator will be able to 

provide you with this information. 

Connection Type radio buttons. 

Use these controls to select the option that matches your type of 

network connection. You can choose between a local area network 

(LAN) connection and a wireless connection. 

Protocol list. 

There are a number of Remote Frame Buffer (RFB) protocols 

available that are supported by VNC. You should only change this 

setting if directed to do so by your Network Administrator. 

Show Mouse check box. 

Use this setting to control whether the mouse pointer on the host 

computer appears in your viewer. You may want to enable this option 

if you want to see where the mouse pointer is being positioned on the 

screen. You may want to disable this option if the presence of the 

mouse pointer is a distraction. 
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The additional options in the "Connect and View Settings" dialog box are 

general settings and apply to all whiteboard interaction, irrespective of the 

chosen device. 

 Colour Scheme list. 

Use this option to apply a default colour scheme to the whiteboard 

viewer. Additional options are also available in the whiteboard viewer 

to control the Colour Scheme setting. 

 Track presenter's position on whiteboard check box. 

Use this option to control the tracking of the focus on the host 

computer. The disabling of this option means that you control the 

movement around the window. You can move around the window by 

using the mouse pointer or by panning around the screen with the 

keyboard. 
  

17.14  Visual Multiple Monitors dialog box 

Menu: Visual > Multiple Monitors 

You choose the multiple monitor options in the Multiple Monitors dialog 

box. 

To use multiple monitors, SuperNova requires a graphics card attached to 

the computer motherboard, such as an AGP/PCI or PCIe graphics card. 

The use of USB graphic card adapters is not supported. 

Options: 

 Display mode for extended desktop group. 

You can use the options in this group to choose the most appropriate 

setup for computers where the desktop has been extended onto 

additional monitors. 

Span radio button. 

You can choose this option if you wish to use two monitors to behave 

as one large monitor. In this scenario, one single desktop will span 

across both monitors. 
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Side by side applications radio button. 

You can use this mode to display different applications on different 

monitors. When working with side by side applications the following 

hot keys are of help: 

 

Function Hot key 

Jump mouse pointer to the 

middle of the next monitor 

CAPS LOCK + 

MIDDLE MOUSE 

BUTTON 

Move application to right monitor WINDOWS Logo Key 

+ SHIFT + RIGHT 

ARROW 

Move application to left monitor WINDOWS Logo Key 

+ SHIFT + LEFT 

ARROW 

 

Presentation Mode check box. 

You use this option to have one monitor showing a magnified screen 

and all the remaining monitors showing an unmagnified screen. For 

example, this will allow you to work on a magnified screen while an 

audience viewing a presentation slide show on the second monitor 

will see an unmagnified screen. 

 Mouse Buffer check box. 

You can use this option to prevent the accidental movement of the 

mouse pointer onto another monitor when you are using an extended 

desktop. You achieve this by creating a level of resistance at the 

screen edge, which means you require additional force to move the 

mouse pointer onto another monitor. You can adjust the level of 

resistance the buffer creates by using the "Resistance" slider. 

 Resistance slider. 

You control the mouse buffer resistance using this slider. The higher 

the level the greater the resistance, which means you have to hold the 

mouse pointer against the edge of the screen for longer to move from 

monitor to monitor. 
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 Switch monitor hot key list. 

When working with "Side by side" applications on an extended 

desktop, you may wish to move the mouse pointer quickly from one 

monitor to the next, without panning the magnification away from the 

area of the screen you are currently viewing. To do this, you can use 

the "Switch Monitor" hot key. The default hotkey to switch between 

monitors is CAPS LOCK + MIDDLE MOUSE BUTTON. 

 Add Key, Replace Key and Remove Key buttons. 

You can use these buttons to change the "Switch monitor" hot key. 

 Allow different magnification levels on each monitor check box. 

This option allows you to have independent magnification levels on 

each of your monitors. This is useful for instance when you have two 

monitors of different sizes and you need a little extra magnification on 

the smaller monitor, or when magnifying smaller text in an application 

on one of your other monitors. 

 Independent colours check box. 

This option allows you to have independent colour schemes on each 

of your monitors. This is useful for instance when you have 

applications on each monitor that require different colour adjustments 

to make easier to view for you. 

 

When you make your SuperNova magnification level and colours 

independent, in SuperNova's control panel the monitor number that the 

magnification level and colour settings belong to will be displayed in the 

"Visual" property sheet (directly underneath the magnification size control). 

 

(Don't forget that you can also make your SuperNova settings 

application-specific). 
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17.15  Visual Advanced Options dialog box 

Menu: Visual > Advanced Options 

You can specify settings for a variety of SuperNova features by selecting 

options in the "Visual Advanced Options" dialog box. 
  

General Preferences tab 

 Highlight Hot Key Action group. 

Visual Highlights can be set to appear in a number of different ways. 

One of these ways is to show the selected Highlights when a hot key 

is pressed. How the hot key behaves when pressed is determined by 

the "Show Highlight" list box. This can be set to "Until Hot Key 

pressed again" or "Until Hot Key released". 

 Fractional Magnification group. 

The "Allow fractional magnification" check box determines whether 

increases in the size of magnification will include fractional values. If 

you turn fractional magnification off, nothing will immediately change. 

Only after the next magnification adjustment will the factor move to 

the nearest linear factor. 

If you experience issues when using fractional magnification sizes 

then options are available to try and improve performance. 

 Overview Mode group. 

The settings in this group determine how the Magnifier position is 

displayed on the screen when in Overview Mode. The magnified area 

can be inverted or the background can be inverted. In this group 

settings also determine the behaviour of the Overview Mode hot key. 

This can be set to "Until Hot Key pressed again" or "Until Hot Key 

released". 

 Video Compatibility button. 

This button will open the "Video Compatibility" dialog box. This dialog 

box contains a number of check boxes for optimising the speed of the 

magnification and resolving screen corruption problems caused by 

non-compliant video drivers. 
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 Mouse Buffer check box. 

The "Mouse Buffer" check box when enabled helps prevent the 

accidental movement of the mouse pointer into or out of your Connect 

and View viewer window when the "Allow mouse pointer to move 

between camera window and desktop" check box is enabled. This is 

achieved by creating a level of resistance at the window border, which 

means you require additional force to move the mouse pointer into the 

other window. You can adjust the level of resistance the buffer creates 

by using the "Resistance" slider. 

 Resistance slider. 

 You control the mouse buffer resistance using this slider. The higher 

the level the greater the resistance, which means you have to hold the 

mouse pointer against the edge of the window for longer to move from 

window to window. 

 Allow mouse pointer to move between camera window and desktop 

check box. 

The "Allow mouse pointer to move between camera window and 

desktop" check box when enabled allows your mouse pointer to move 

freely between the Connect and View viewer window and any 

application currently running on your Windows desktop, such as your 

word processor. If this option is unchecked the mouse can be 

switched between the Connect and View viewer window and your 

Windows desktop using the hot key CAPS LOCK + MIDDLE MOUSE 

BUTTON. 
  

Magnifier tab. 

 Lock Aspect check box. 

If the "Lock Aspect" check box is unselected then you will have two 

spin controls that will allow you to adjust the horizontal and vertical 

magnification size independently. If you turn lock aspect ratio back on, 

the magnification factor will change to the average of the horizontal 

and vertical factors. Note that True Fonts is unsupported when  

working with a different horizontal and vertical magnification size. 
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 Font Smoothing group. 

Font smoothing improves the legibility of the text on the screen when 

you use magnification. Options include: 

None radio button. 

Choose "None" to turn off Font Smoothing. 

Standard radio button. 

Choose "Standard" for basic font smoothing. Use this option if you 

are experiencing performance issues using True Fonts. 

True Fonts radio button. 

Choose "True Fonts" for perfect clarity at all magnification sizes. You 

may wish to experiment with the True Font Settings if you are using a 

magnification size of 3x or lower or you are using an LCD monitor. 

 True Fonts Settings group. 

Standard radio button. 

Using "Standard" renders text in a non- antialiased mode. This is the 

default and fastest method, especially when using a magnification 

size of 4x or greater. 

Antialiased radio button. 

This setting renders  the text and smooth's the text edges. If you 

experience jagged effects using True Fonts at a low magnification 

size then you should select this option. 

You can switch between "None", "Standard" and "True Fonts" by using a 

SuperNova hot key. 

Magnifier Hot Keys 

Function Desktop - 
Default 

NumPad Set 

Laptop - 
Universal Set 

Font Smoothing LEFT 

CONTROL + 

NUMPAD 8 

No 

Assignment 

Note that True Fonts is unavailable if you are using a different vertical and 

horizontal magnification ratio. You can independently change the vertical 

and horizontal magnification size by deselecting the "Lock Aspect" check 

box in the "Visual Advanced Options" dialog box. 
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Tracking tab. 

 Mouse tracking group. 

In this group the "Track mouse pointer" check box controls whether 

SuperNova follows the mouse pointer. When tracking the mouse 

pointer the window will scroll whenever the mouse is moved beyond 

the mouse frame. The distance that it moves will normally be just 

enough so that the mouse ends up at the edge of the screen or 

margin. To adjust the mouse frame, press the mouse frame button. 

This takes you to the Mouse and Foci Frame Dialog Box. 

The "Move mouse pointer into view" check box determines what 

happens when the mouse pointer is currently not visible inside the 

magnified window. With this option selected, when the mouse pointer 

is initially moved, the mouse pointer will be brought to the centre of 

the magnified window. If this option is unselected then the magnified 

window will be moved to the mouse pointer's location on the screen. 

If the "Stay in window" check box is selected, artificial mouse 

boundaries are created around the currently selected window. This 

places a restriction on the mouse pointer so the display does not 

easily move away from the current window. These mouse boundaries 

are removed if you move the pointer beyond the edge of the window. 

 Cursor tracking group. 

The "Track Cursor" check box controls whether the Magnifier follows 

the beam cursor inside edit areas. If this checkbox is selected, the 

magnified window will move to show the area around the cursor as it 

moves. The Cursor Frame (the minimum distance between the beam 

and the edge of the screen) can be set in the Caret Frame dialog box 

by pressing the "Cursor Frame" button. 

 Focus tracking group. 

In this group you can control whether the Magnifier tracks other types 

of Windows controls. Available options are menus, controls and 

windows. 

The "Keep focus in centre" check box sets whether any controls that 

are being tracked such as menus and small dialog boxes are to be 

centred in the magnified window if they fit. If "Keep focus in centre" is 

not selected the display will move the minimum amount possible to 

make the object completely visible. 

The "Track Narrator" check box controls whether Windows Narrator's 
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focus highlight is tracked when Narrator is running. (Requires 

Windows 10 build 17763 or greater). 
  

Line View tab. 

Line View is a SuperNova reading mode. In this mode the content of the 

visible screen is shown as a single line scrolling across the screen. Line 

View lets you control background and text colour, text size and what font to 

use. 
  

Hooked Areas tab. 

Hooked Areas allow you to keep a particular area of the screen 

permanently displayed. This lets you keep an eye on important information 

that may frequently change as you use your application. 
  

17.15.1  Enhancement tab 

Enhancement tab 

 Font Enhancement group. 

The "True Fonts Bold" check box adds boldness to True Font 

magnified text. 

The "Standard Bold" check box adds boldness to non-True Font 

magnified text, such as the text found in the Windows 10 Start menu 

and in the content pane of Google Chrome and Mozilla Firefox. 

The "Low", "Medium" and "High" radio buttons control the amount of 

boldness added to the magnified text. 

 Image Enhancement group. 

The "Sharpen" check box controls whether SuperNova sharpens 

magnified images (including photographs) as well as non-True Font 

text. 

If the "Sharpen" check box is enabled SuperNova will sharpen 

magnified images and non-True Font text by exaggerating the 

brightness difference along any edges on your screen, thus making 

those edges appear more pronounced. The sharpening process 

works by subtracting a slightly blurred version of your screen image 

from your original screen image in order to detect the presence of 
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edges, creating what's known as a "mask". Using this mask the 

contrast along the detected edges is then selectively increased 

leaving behind a sharper image. 

The "Contrast" slider controls the minimum brightness difference  

sharpened. This can be used to sharpen more pronounced edges, 

while leaving more subtle edges untouched. It's especially useful to 

avoid sharpening noise. 

The "Size" slider controls the size of the edges you wish to enhance, 

where a smaller size enhances smaller detail. You'll usually want a 

size setting that's comparable to the size of the smallest detail within 

your image. The key to effective sharpening is finding the right 

settings for making edges appear sufficiently pronounced while 

minimising sharpening "halos". 

 

Note: The Standard bold and Sharpen options are not available on 

Windows 7. 

 
  

17.16  General Startup Preferences dialog box 

Menu: General > Startup Preferences 

You can specify settings for a variety of SuperNova features by selecting 

options in the "Startup Preferences" dialog box. The availability of some 

options depends on the synthesiser you are using and whether you are 

running a local, network or USB edition of SuperNova. 

Options 
  

 Launch SuperNova after logon check box. 

You can set your computer to automatically run SuperNova after you 

log into your user account by selecting this check box. 
  

 Disable splash screen at startup check box. 

You can stop the SuperNova splash screen showing by selecting this 
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check box. A splash screen is an image that appears while a 

computer program is loading. 
  

 Magnifier at user logon check box. 

You can magnify the Windows Logon Screen by selecting this check 

box. After selecting this check box, the next time you restart your 

computer you will have a SuperNova toolbar showing on the Windows 

Logon Screen. You can use the mouse to click the toolbar buttons to 

adjust magnification or press F7 to reduce magnification and F8 to 

increase magnification. 

Note: Magnification at the Windows Logon Screen is only possible by 

having a SuperNova component running as a Windows service. You 

cannot run a full program at the Windows logon screen because of 

Windows security restrictions. 
  

 Show magnification buttons at logon check box. 

You can hide the SuperNova toolbar that appears at the Windows 

Logon Screen by deselecting this item. 
  

 Always save user settings check box. 

By default, SuperNova will automatically save changes you make to 

SuperNova settings. You can prevent this behaviour by deselecting 

the "Always save user settings" check box. When this check box is 

unselected then you must manually save the changes you make. You 

can do this by selecting the "Save Settings" option in the "File" menu. 

  

 
  

 Ask user check box. 

The "Ask user" check box becomes available when you deselect the 

"Always save user settings" check box. If you select the "Ask user" 

check box, then SuperNova will ask you if you want to save the 

changes you have made when you quit SuperNova. 
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17.17  General Update Settings dialog box 

Menu: General > Update Settings 

The "Update Settings" dialog box sets when SuperNova automatically 

checks for updates. SuperNova can check daily, weekly, monthly or never. 

You can also keep SuperNova up-to-date by selecting "Check for Updates" 

from the "Help" menu. 
  

17.18  General Control Panel dialog box 

Menu: General > Control Panel 

The "Control Panel" dialog box contains global settings to control the 

SuperNova user interface. 
  

 Access System Language list. 

This list box lets you change the SuperNova system language. This 

includes all of the text in the SuperNova control panel, synthesiser 

output language and help files. 
  

 Enable helpful warnings check box 

This checkbox switches the helpful warnings on or off. An example for 

a helpful warning is the graphics training: If you press the hot key for 

graphic training but graphic training is switched off you can get a 

warning. 
  

 Enable help messages check box. 

Help messages can appear to guide you through specific tasks.  If 

this option is unselected then these messages will not appear.  It is 

also possible to disable specific help messages when they appear by 

unselecting the "Do not show this message again" check box within 

the message window itself. 
  

 Use Default Settings in the control panel check box. 

By default, you will use the current SuperNova settings when going 

through the SuperNova control panel. This lets you experience the 

effects of change to settings as they happen. 
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In some cases, settings you wish to use in your application may not 

be suitable for the SuperNova control panel. Selecting this check box 

means SuperNova will switch to use the Default Application settings 

and not your custom Application Settings. 
  

 Hide when minimised check box. 

You can prevent the SuperNova control panel being on the Taskbar 

and part of the "Switch To" dialog box by selecting this check box. 

You can continue to access the SuperNova control panel with the 

"Open control panel" hot key or through the System Tray. 
  

 Menu bar and Button Bar Style radio buttons. 

You can show the SuperNova control panel only as a menu bar or as 

a menu bar and button bar. The Button Bar Style includes large 

graphical buttons which offer easy access to the main SuperNova 

settings. 
  

 Status bar check box. 

You can hide the status bar that is part of the SuperNova control 

panel by deselecting this check box. 

The status bar contains information about the application and the 

current settings file in use. All changes you make in the control panel 

apply to this settings file. 
  

 Always on top check box. 

If this setting is enabled then the SuperNova control panel will always 

be on top of other windows.  
  

 Start with panel ... radio buttons. 

You can control the appearance of the SuperNova control panel when 

SuperNova starts. You can set the control panel to be showing, 

minimised or at the same position when you last closed SuperNova. 
  

17.18.1  Control Panel Theme 

 Control Panel Theme list. 

This list box lets you change the colours displayed in SuperNova’s 

control panel by allowing you to select one of a number of pre-defined 

colour schemes. The default setting is "System Colours", which 
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makes SuperNova use the colours of your currently chosen Windows 

colour scheme. 
  

17.19  General Keyboard dialog box 

Menu: General > Keyboard and Hot Keys > Keyboard 

You can specify what keyboard layout and hot key set you want to use in 

the "Keyboard" dialog box. 

Options: 

 Keyboard list. 

The "Keyboard" list box sets the keyboard type. This does not have to 

be a true reflection of the keyboard you are using. 

 Language list. 

The "Language" list box should match your Windows keyboard layout. 

The value relates to Keyboard Announcements and hot key 

assignments. 

 Set list. 

The "Set" list box specifies the hot key set to be used. The sets 

available will be restricted by the selections in the "Keyboard" list and 

"Language" list. 

 Restore default hot keys button. 

You can restore any changes you may have made to a hot key set by 

selecting this button. 

 Num Lock On enables Number Pad keys check box. 

You can enter numbers using your keyboard's Number Pad by 

selecting this check box. If you do select this option then turn the Num 

Lock Off to use SuperNova hot keys that use the Number Pad. 
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17.20  General Hot Keys dialog box 

Menu: General > Keyboard and Hot Keys > Hot Keys 

 You can add, replace or remove any hot key assignments to SuperNova 

commands by using options in the "Hot Keys" dialog box. Note that the list 

of commands are global commands. Hot keys defined in Scripts and Maps 

cannot be changed using this dialog box. 

To learn more about modifying hot keys, see the "Resolve Hot Key 

Conflicts" topics in this user guide. 
  

17.21  General Touchscreen Settings dialog box 

Menu: General > Touchscreen Settings 

The "Touchscreen Settings" dialog box contains options that you can use 

to adjust the SuperNova touchscreen experience. 
  

General tab. 

 Double tap timeout slider. 

This setting controls the duration between first and second taps for 

the gesture to be considered a double tap action. You can increase 

the time allowed between the first and second taps by moving the 

slider to the right. 

 Jitter Margin slider. 

The Jitter Margin is The distance an initial touch can wander before 

SuperNova thinks you are performing a swipe gesture. You can 

increase the allowable distance by moving the slider to the right. 
  

Magnification tab. 

 Display Touch Bar check box. 

The SuperNova Touch Bar is a touchscreen toolbar that appears at 

the bottom of the screen when you do a 3 finger  single tap. As well 

as using the gesture, you can also control the appearance of the 

Touch Bar by adjusting the status of this check box. 



 

Reference 133 

 

 Flick Inertia slider. 

Performing a single finger swipe moves the magnified screen with 

inertia. The faster you perform the swipe the further the SuperNova 

magnified screen travels. This slider controls the level of resistence 

SuperNova applies to the motion. You can reduce the level of 

resistence by moving the slider to the right. 

 Auto-Scroll Zone Width slider. 

The "Auto-Scroll Zone Width" is the distance your finger needs to be 

from the edge of the screen before SuperNova starts automatically 

scrolling the rest of the screen into view. You can increase the size of 

the margin by moving the slider to the right. 

 Auto-Scroll Zone Speed slider. 

The "Auto-Scroll Zone Speed" sets how fast SuperNova starts 

automatically scrolling when your finger enters the auto-scroll zone. 

You can increase the auto-scrolling speed by moving the slider to the 

right. 

 Pass-Through Timeout slider. 

The "Pass-Through Timeout" is the duration before which a press 

turns into a pass-through gesture. 

 Automatically Scroll applications check box. 

This setting controls whether a swipe gesture automatically scrolls the 

content within an application window when the magnified window is at 

the edge of the screen. For example, if you are reading a web page 

and the magnified window is at the bottom of the screen, performing a 

swipe will automatically scroll the web page, bringing more content 

into view. Applications that support this feature include the Start 

Screen, Internet Explorer, Adobe Reader and Microsoft Word. 
  

On Screen Keyboard tab. 

 Automatically Open in Desktop Apps check box. 

SuperNova automatically shows the onscreen keyboard when you 

need to type and you do not have a keyboard connected to the device. 

You can turn off the automatic appearance of the onscreen keyboard 

when you are using desktop applications by deselecting this setting. 

With this setting turned off, you can still make the keyboard appear at 
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any time by tapping the Keyboard button in the SuperNova Touch Bar 

or by tapping the Keyboard button in the Windows Notification area. 

 Colour Scheme list. 

You can change the appearance of the SuperNova onscreen 

keyboard by choosing an alternative colour scheme from this list. The 

colour schemes available offer large print high contrast colour 

combinations to make it easy to view the keyboard. 
  

17.22  General Advanced Options dialog box 

Menu: General > Advanced Options 

You can specify settings for a variety of SuperNova features by selecting 

options in the "General Advanced Options" dialog box. 
  

System Configuration tab 
  

 Windows Settings button. 

SuperNova makes some changes to your system to ensure best 

accessibility. You can disable any of the changes made by selecting 

this button to open the "Windows Settings" dialog box and deselecting 

any listed item. 
  

Detection Settings tab 
  

 Allow remote mapping check box. 

You can enable remote mapping by selecting this check box. This 

allows computers running the Dolphin remote training utility to connect 

to your computer. 

For security reasons, if you enable this option it will be automatically 

turned off when you quit SuperNova. 

 Read in columns if present check box. 

You can organise the screen into columns based on SuperNova's 

internal detection system by selecting this check box. This influences 

the reading options in SuperNova in areas with no Document Object 

Model (DOM). 
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17.23  Item Finder dialog box 

Menu: General > Item Finder 

You can use the Item Finder to list certain objects in an application window. 

You can then select the objects and perform actions upon them. Examples 

include clicking a link on a web page or moving to a heading in a 

document. 

You can use the item finder in programs like Microsoft Office and Internet 

Explorer. 

If you are in an application that does not support the Item Finder then the 

Item Finder is disabled. 

To learn more about the Item Finder and the support it offers for your 

application see the SuperNova Help available for your application. 
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